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IMPORTANT NOTICE 

All statements, technical information, and recommendations in this document which relate to the products supplied 
by Meggitt SA are based on information believed to be reliable, but unless otherwise expressly agreed in writing 

with Meggitt SA the accuracy or completeness of such data is not guaranteed. Before using this product, you must 
evaluate it and determine if it is suitable for your intended application. You should also check our website at 

www.meggittsensing.com/energy for any updates to data sheets, Ex certificates, product drawings, user manuals, 
service bulletins and/or other instructions affecting the product. 

Unless otherwise expressly agreed in writing with Meggitt SA, you assume all risks and liability associated with use 
of the product. Meggitt SA takes no responsibility for any statements related to the product which are not contained 

in a current English language Meggitt SA publication, nor for any statements contained in extracts, summaries, 
translations or any other documents not authored and produced by Meggitt SA. 

The certifications and warranties applicable to the products supplied by Meggitt SA are valid only for new products 
purchased directly from Meggitt SA or from an authorised distributor of Meggitt SA. 

Meggitt SA reserves the right to alter any part of this publication without prior notice. 
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PREFACE 
 

About these release notes 

This document provides important information about the VibroSight® software from Meggitt SA. It is applicable to all 
VibroSight-based condition monitoring systems using the versions of software described by this document, namely: 

• VibroSight software version 7.2.0 
(part numbers (PNRs) software license: 608-001-000-001/Codes 
and software: 609-010-000-001 on physical media (USB device (flash drive/key))). 

This document contains information about changes to the software since the previously released version 
(VibroSight 7.1.x), such as new features and improvements, solved problems and bug fixes, and hardware and 
software compatibility. 

For more general information on the actual software, or the entire machinery protection system (MPS) and/or 
condition monitoring system (CMS), refer to the following Meggitt SA documentation: 

 VibroSight® software data sheet 
        (document reference 660-020-005-226A) 

 Getting started with VibroSight® installation guide 
        (document reference 660-010-006-232A) 

 VibroSight® help 

 VM600Mk2 MPC4Mk2 + IOC4Mk2 machinery protection and condition monitoring module data sheet 
        (document reference 268-121) 

 VM600Mk2 RLC16Mk2 relay module data sheet 
        (document reference 268-125) 

 VM600Mk2 CPUMMk2 + IOCNMk2 rack controller and communications interface module data sheet 
        (document reference 268-135) 

 VM600Mk2/VM600 XMx16 + XIO16T extended condition monitoring modules data sheet 
        (document reference 660-020-010-211A) 

 VibroSight application notes and technical notes. 

 

Users who are familiar with VibroSight may also find it useful to refer to the release notes included in earlier 
versions of the software: 

• VibroSight 7.1.0 (document reference 660-010-013-234A) 

• VibroSight 7.0.0 (document reference 660-010-013-233A) 

• VibroSight 6.1.0 (document reference 660-010-013-232A) 

• VibroSight 6.0.0 (document reference 660-010-013-231A) 
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• VibroSight 5.1.0 (document reference 660-010-013-230A) 

• VibroSight 5.0.0 (document reference 660-010-013-229A) 

• VibroSight 4.1.0 (document reference 660-010-013-228A) 

• VibroSight 4.0.0 (document reference 660-010-013-227A) 

• VibroSight 3.8.0 (document reference 660-010-013-226A) 

• VibroSight 3.7.0 (document reference 660-010-013-225A) 

• VibroSight 3.6.0 (document reference 660-010-013-224A) 

• VibroSight 3.5.0 (document reference 660-010-013-223A) 

• VibroSight 3.4.0 (document reference 660-010-013-222A) 

• VibroSight 3.3.0 (document reference 660-010-013-221A) 

• VibroSight 3.2.0 (document reference 660-010-013-220A) 

• VibroSight 3.1.0 (document reference 660-010-013-219A) 

• VibroSight 3.0.0 (document reference 660-010-013-218A) 

• VibroSight 2.12.7 (document reference 660-010-013-217A) 

• VibroSight 2.12.6 (document reference 660-010-013-216A) 

• VibroSight 2.12.5 (document reference 660-010-013-215A) 

• VibroSight 2.12.4 (document reference 660-010-013-214A) 

• VibroSight 2.12.3 (document reference 660-010-013-213A) 

• VibroSight 2.12.2 (document reference 660-010-013-212A) 

• VibroSight 2.12.1 (document reference 660-010-013-211A) 

• VibroSight 2.12.0 (document reference 660-010-013-210A) 

• VibroSight 2.11.6 (document reference 660-010-013-209A) 

• VibroSight 2.11.5 (document reference 660-010-013-208A) 

• VibroSight 2.11.4 (document reference 660-010-013-207A) 

• VibroSight 2.11.3 (document reference 660-010-013-206A) 

• VibroSight 2.11.2 (document reference 660-010-013-205A) 

• VibroSight 2.11.1 (document reference 660-010-013-204A) 

• VibroSight 2.11.0 (document reference 660-010-013-203A) 

• VibroSight 2.10.1 (document reference 660-010-013-201A) 

• VibroSight 2.10.0 (document reference VIBROSIGHT-RN/E) 

• VibroSight 2.9.7 (document reference VIBROSIGHT-RN/E) 
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• VibroSight 2.9.6 (document reference VIBROSIGHT-RN/E) 

• VibroSight 2.9.5 (document reference VIBROSIGHT-RN/E) 

• VibroSight 2.9.4 (document reference VIBROSIGHT-RN/E) 

• VibroSight 2.9.2 (document reference VIBROSIGHT-RN/E) 

• VibroSight 2.9.1 (document reference VIBROSIGHT-RN/E). 

 

Use of the release notes 

You should read those sections that are most relevant to you and then keep the document for future reference. 

 

Version identifiers 

A complete VibroSight software version number has four components that provide the following information: 

• x.x.x.x, major release identifier – typically incremented once per year. 

• x.x.x.x, minor release identifier – incremented for each release with typically four scheduled releases per year. 

• x.x.x.x, “hotfix” release identifier – 0 for a normally scheduled release and incremented for each hotfix release. 

• x.x.x.x, software build number – for internal use. 

For each scheduled release of VibroSight, at least one of the first two digits changes (x.x.x.x). 
For unscheduled “hotfix” releases, which are occasionally required to solve urgent problems, the third digit changes 
(x.x.x.x). 

The version identifiers for installed software appear in the Help About box (obtained using Help > About … in any 
VibroSight software module). 
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Terminology 

To distinguish between the different Meggitt SA products that can be used with the VibroSight® software, the 
following terminology is used in this document: 

 

• VM600Mk2/VM600 modules/card(s) – to refer to VibroSight compatible cards that are installed in a 
VM600Mk2/VM600 rack (that is, the first generation of VM600 systems). 

The currently available VM600Mk2/VM600 modules/cards that are designed for operation with the VibroSight 
software are the XMx16 card pairs (XMC16 / XIO16T, XMV16 / XIO16T and XMVS16 / XIO16T) and the 
CPUx card pairs (CPUR2/IOCR2 and CPUR/IOCR). 

Note: It is important to note that VibroSight Configurator is still used for the configuration of these 
VM600Mk2/VM600 modules/cards/systems. 

Where XMx16 is used in this document, it refers to XMC16 / XIO16T, XMV16 / XIO16T and XMVS16 / XIO16T 
cards, unless otherwise stated. 

Where CPUx is used in this document, it refers to CPUR2/IOCR2 and CPUR/IOCR cards, unless otherwise 
stated. 

 

• VM600Mk2 module(s) – to refer to VibroSight compatible modules that are installed in a VM600Mk2 rack (that is, 
the second generation of VM600 systems). 

The currently available VM600Mk2 modules that are designed for operation with the VibroSight software are the 
MPC4Mk2 + IOC4Mk2 machinery protection and condition monitoring module, the RLC16Mk2 relay module and the 
CPUMMk2 + IOCNMk2 rack controller and communications interface module. 

Note: It is important to note that VibroSight Protect is used for the configuration of VM600Mk2 modules/systems. 

 

• VibroSmart® module(s) or VibroSmart® device(s) – to refer to VibroSight compatible VibroSmart modules or 
devices that are used in a VibroSmart distributed monitoring system. The currently available VibroSmart 
modules and devices that are designed for operation with the VibroSight software are the VSI010, VSN010 and 
VSV30x. 

Where VibroSmart module is used in this document, it refers to the VSI010 and VSV30x modules, unless 
otherwise stated. 

Where VibroSmart device is used in this document, it can refer to the VSN010 device only, or to the VSI010 
and VSV30x modules and the VSN010 device, unless otherwise stated. 

Where VSV30x is used in this document, it refers to VSV301 and VSV300 modules, unless otherwise stated. 
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1 Licensing 

Since VibroSight 4.0.0, the ability to install and run VibroSight software updates and upgrades depends on the 
purchased “Updates and support” package. 

NOTE: VibroSight 7.2.0 is a minor level release and a new license key file is not required 
for updates and upgrades from VibroSight 7.x.x. 

However, a new license key file is required for updates and upgrades from 
VibroSight 3.8.x or earlier. 

 

For further information on licensing or to obtain a new VibroSight license key file, contact Meggitt SA customer 
support. See 8 Customer support. 

 

2 Features 

General 

2.1 Support for the next generation of diagnostic rulebox 

VibroSight 7.2.0 introduces initial support for the latest generation of the VibroSight diagnostic rulebox, that is, 
an improved implementation of our existing diagnostics rule box solution. 

Integrated into VibroSight Capture, the VibroSight software module for the configuration and operation of the 
condition monitoring (CMS) functionality of a VM600Mk2 system, the new VibroSight diagnostics rulebox is a more 
powerful, fully-automated, decision support system for use by machinery operators and experts that further 
supports the effective monitoring of all rotating machinery. 

NOTE: The VibroSight diagnostic rulebox applies diagnostic rules and decision support 
tasks configured for an application/system to real-time data so that it can quickly 
and automatically provide information required to support the operation and 
maintenance of machinery. 

 

The addition of the VibroSight diagnostic rulebox to VibroSight Capture provides a much more tightly-integrated 
decision support system that is easier to configure and use. For example, outputs from the VibroSight diagnostic 
rulebox are sent directly to the VibroSight Event Viewer – so there is less software for users and operators to have 
to learn. 

(Previously, equivalent solutions required the VibroSight software and the separate VibroSight diagnostics rule box 
software, with communications between the two using a OPC DA (OPC Classic) interface for the export of real-time 
data from the VibroSight database (*.vsdhf).) 
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2.1.1 VibroSight diagnostic rulebox user interface 

As it is integrated into VibroSight Capture, the user interface for the VibroSight diagnostic rulebox is available on 
the Data tab/page of VibroSight Capture, under Diagnostic rulebox. This is shown in Figure 1. 

 

 
Figure 1: VibroSight diagnostic rulebox in VibroSight Capture 

 

 

2.1.2 Getting started with VibroSight diagnostic rulebox 

Using the VibroSight diagnostic rulebox (in VibroSight Capture) to add diagnostics to a VM600Mk2 system (MPC4Mk2 
+ IOC4Mk2 module) requires a few simple steps: 

 

• Adding diagnostic rule groups – which are used as “containers” for collections of related diagnostic rules. For 
example, different groups could be developed containing rules that are applicable to different machines. 

In the Diagnostic rulebox, click the Add your first diagnostic rule group “+” box (main window, centre, 
see Figure 1) to add a diagnostic rule group. The main window (centre) updates to display information for the 
diagnostic rule group just added (selected), and the Diagnostic rulebox window (right top) lists the rule group. 

Alternatively, in the Diagnostic rulebox window (right top), the “+” control can be used to add diagnostic rule 
components: diagnostic rule groups or diagnostic rules. Please note that diagnostic rules can only be added 
under diagnostic rule groups. 
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Similarly, in the Diagnostic rulebox window (right top), the “−” control can be used to remove the selected 
diagnostic rule component: diagnostic rule groups or diagnostic rules. Please note that when a diagnostic rule 
group is deleted, any associated (contained) diagnostic rules are also deleted. 

It is important to note that when a diagnostic rule group is added, it must be associated with a machine. So in 
the main window (centre), for a diagnostic rule group, under Machines (left), use the Add control to associate a 
machine (machine train) with the diagnostic rule group. 
Note: This is necessary in order for the associated (contained) diagnostic rules to be able to see the 
data/information available from the machinery. 

NOTE: In VibroSight diagnostic rulebox, a rule group is intended to be used to contain the 
rules that are applicable to machines of the same type, like a library/template. 

(For reference, previous solutions using the VibroSight software and the separate 
VibroSight diagnostics rule box software required that rules were created on a 
machine by machine basis – even if they were identical.) 

 
Note: At any time, the History window (right bottom) is used to undo/redo operations in the configuration. 

 
• Adding diagnostic rules – these are the rules that will actually process the input data in order to generate the 

outputs. 

In the Diagnostic rulebox window (right top), select a diagnostic rule group, then use the “+” control to add a 
diagnostic rule to the group. The main window (centre) updates to display information for the diagnostic rule 
just added (selected), and the Diagnostic rulebox window (right top) lists the rule. This is shown in Figure 2. 

 

  
Figure 2: Diagnostic rule groups and diagnostic rules in VibroSight diagnostic rulebox (VibroSight Capture) 
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• Configuring the diagnostic rules – specify how the rules will actually process the input data and the required 
outputs (results/actions). 

 

Inputs 

For a diagnostic rule, in the main window (centre), under Inputs (left), use the Add control to add inputs to the 
rule. 

Note: As each input is added, it is automatically assigned a letter (starting with the letter “a”) that uniquely 
identifies the input, so that it can be processed in the Conditions section (below), as required. 

Inputs are defined in terms of Machine state, Measurement quality, Measurement severity or Measurement 
value, which is done using the first drop-down box on an input row. The subsequent controls on each input row 
are used to further define the input, for example, in terms of measurement name, etc. See Figure 2. 

Please note that at the end of each input row, there is a corresponding Test value box that can be used to 
assign values to inputs in order to help test any expressions in the Conditions section (below). 

The Phase unit and Frequency unit controls at the bottom of the Inputs section are used to define the units to 
be used by these physical quantities in the VibroSight diagnostic rulebox. 

 

Conditions 

For a diagnostic rule, in the main window (centre), under Conditions (left), there is a box for each type of 
severity condition that can be evaluated by a diagnostic rule, that is, Information, Alert and Danger. 

Click in a Conditions box (Information, Alert or Danger) to enter an expression consisting of basic 
mathematical, relational and/or logical operators that will be evaluated in order to produce a boolean output 
(true or false). If the output of the condition/expression is true, then the corresponding Event below the 
Condition is triggered. If the output is false, then the Event below the Condition is not triggered. 

Note: Inputs are treated as variables in expressions. Simply substitute the letter automatically assigned to an 
input in the Inputs section (above) in order to use the input in an expression, as required. 

Please note that when an expression is added to a condition box (Information, Alert and/or Danger), a Result is 
displayed directly below the box. This result (true or false) is the evaluation of the condition/expression using 
the values from the Test value boxes in in the Inputs section (above) and is provided to help develop and test 
expressions. 
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A summary of the basic mathematical, relational and/or logical operators that can be used in 
condition/expressions is as follows: 

 

The math expressions can mix scalar, vector or matrix type. The following standard operators are supported:  

', the transpose/adjungate operator for matrices 

power operator ^ 

standard operators working on vector, matrix and scalar *, /, + , - 

The per element operators working on matrices and vectors *. , /. 

If you don’t specify per element operation, linear algebra logic will be used for * and / when operands are matrices 

 

factorial operator ! 

percentage operator % 

back divison operator for matrices , AB = A^(-1)*B, which comes from A*X = B and gives a solution to the system of linear 
equations. If matrices are not square LQR (minimum norm) solution is computed. 

div and mod for integer division 

comparison operators < , <= , > , >= , == 

binary operators: and, not, or, xor 

assign operator, = 

colon operator, : (for ranges) 

 

The "i" defines a complex number:  

a = 2+3i;  

All operations support complex numbers. When using expressions which can result in a complex number like: (-1)^(1/3), the 
result will be complex, only if arguments are complex. The expression will also not auto reduce to a real number, even if 
imaginary part of the complex number is 0. To reduce the result to the real number part only, you have to call function 
real(x). To explicitely form a complex number use the cplx(re, im) function. The iscomplex(x) function returns 1 if the 
variable is complex and 0 otherwise. 

 

It is of course possible to evaluate a list of expressions:  

a = 1;  

b = 2;  

c = a + b;  

where the variables will remain in the memory until cleared. 
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The precedence of the operands is little different from Pascal (Delphi), giving a lower precedence to logical operands, as 
these only act on booleans (and not on integers like in Pascal): 

(highest): ! -x +x % 

^ 

* / div mod 

+ - 

> >= < <= <> = 

not 

or and xor 

(lowest) = 

 

The Add function control below each condition box (Information, Alert and/or Danger) are used to add more 
advanced mathematical functions to the expression in a processing box. 

 

Events 

For a diagnostic rule, in the main window (centre), under Events (left), there is a box for each type of severity 
message that can be used by a diagnostic rule, that is, Information, Alert and Danger. 

Click in an Events box (Information, Alert or Danger) to enter a text phrase/string to be used as the “messages” 
associated with this particular diagnostic rule when an event is generated. 

For example, if the Alert severity message is “Investigate unit 1”, then when the VibroSight diagnostic rulebox 
generates this event, the VibroSight Event Viewer will include the message as part of the event: 

Date / Time  Event type  Name     … Message 
06.01.2023 14:30:00 Diagnostic rulebox Alert severity rule triggered  … Investigate unit 1 

 

The Command line box below the Events boxes is used to specify an external executable or script file that the 
VibroSight diagnostic rulebox will also run when it generates an event. 

The Command line should be formatted as: 

C:\example_script.bat %sev %a %b 

Where 
example_script.bat  is the name of the external executable such as a Windows batch file. 
%sev  is the event severity level that generated/triggered the event, which can used by the external executable, 
as required. 
%a  is the value of input a, that is, the input automatically assigned as a in the Inputs section (above),  
%b  is the value of input b, that is, the input automatically assigned as b, and so on. 
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The Time delay box below the Events boxes is used to specify the time duration for which a 
condition/expression must be true before the VibroSight diagnostic rulebox will generate an event. 

 

It is important to realise that the VibroSight diagnostic rulebox generates events when the condition/expression 
for an event remains true for the duration of the required time period. Accordingly, the condition/expression for 
an event must become false, then true again for the duration of the time period before an event can be 
generated a second time, and so on. 

 

• Saving and running the VibroSight diagnostic rulebox configuration 

After the VibroSight diagnostic rulebox has been configured, because it is part of VibroSight Capture, it can be 
saved and activated in the usual way. 

As usual, the Consistency checks window (bottom) should be used to help correct any configuration errors and 
warnings as they occur, thereby helping ensure that a valid configuration is arrived at. 

 

Once the VibroSight Capture configuration has been saved as a VibroSight Server using the 
File > Save as server … command and any changes have been applied using the 
File > Apply changes to active configuration … command, it is only necessary to ensure that the 
Server Features – Diagnostic rulebox control is enabled on the Status tab/page of the VibroSight Server in 
order for the VibroSight diagnostic rulebox to run. 

 

 

NOTE: VibroSight 7.2.0 introduces initial support for the VibroSight diagnostic rulebox and 
as such is currently limited to static data only (not dynamic data) and operation with 
VM600Mk2 systems (MPC4Mk2 + IOC4Mk2 modules). 
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2.2 VM600Mk2 MPC4Mk2 support for rotor expansion (pendulum) processing 

VibroSight 7.2.0 adds support for Rotor expansion (pendulum) processing and measurement, a single-channel 
processing, when using the VM600Mk2 MPC4Mk2 + IOC4Mk2 module’s dynamic or auxiliary channels. 

NOTE: Rotor expansion (pendulum) processing is similar to the existing support for rotor 
expansion (collar) processing, except that the pendulum method utilises a magnet 
on a lever arm in order to follow the movement of the shaft collar, such that the 
lever arm ratio (L1 / L2) enables the measurement range to be extended well 
beyond that of a sensor used on its own. 

 
More specifically, VibroSight Protect now allows individual VM600Mk2 MPC4Mk2 dynamic and/or auxiliary channels 
to be configured for Rotor expansion (pendulum) processing using proximity sensors / measurement chains on 
CH1-CH4 and/or AX1-AX2. 

In VibroSight Protect, when configuring Rotor expansion (pendulum) processing for machinery protection, it is 
necessary to configure a dynamic or auxiliary channel for use with proximity sensors / measurement chains, such 
as the TQxxx/IQSxxx. First, click/select the dynamic or auxiliary measurement channel, then configure the channel 
by selecting Processing type: Single, Sensor family: Proximity probes, then Rotor expansion (pendulum). 

Then, when prompted to configure the sensors / measurement chains (Configuration of a channel), use the Add 
control to select the proximity probe (and measurement chain) from the Library in order to use a sensor / 
measurement chain with default values. Alternatively, under the Library list, use the Add control to add a new 
sensor chain (vibro-meter or generic) to the list, or use the Duplicate and/or Edit controls to modify an existing 
sensor / measurement chain as required. 

 
In VibroSight Protect, when configuring Rotor expansion (pendulum) processing for machinery protection, it is 
important to note that: 

• A proximity probe (sensor) is required. 

• A dynamic (CH1-CH4) or auxiliary (AX1-AX2) channel can be used. 

• An initial gap must be configured (in mechanical (displacement) or electrical units) and the specifications of the 
lever arm must also be configured. This is done on the Processing tab for the measurement channel. 

• A Range inverted control is available in order to be able to configure the direction/sense of the measurement 
output range. This is also on the Processing tab for the measurement channel. 

• Only a single quasi-static rotor expansion measurement (with alarms) is provided. 

 

In VibroSight Capture, when configuring Rotor expansion (pendulum) processing for condition monitoring, it is 
important to note that: 

• For the component/processing selected in the Machinery image (top), the name and type of measurement is 
displayed (bottom, left), while more detailed information for the associated processing and measurements is 
displayed (bottom, centre) across three tabs: General, Processing and Alarms. 
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• The information displayed is a combination of: 

• The information imported from the associated machinery protection system (MPS) configuration, that is, the 
measurements (sensors / measurements chains, processing and alarms) imported from the 
VibroSight Protect configuration. 

• The default condition monitoring measurements (processing and alarms) that are automatically generated by 
VibroSight Capture, depending on the VibroSight Protect configuration. 

 

In general, on the Processing tab, under Condition monitoring, the default settings can be changed as required. On 
the Alarms tab, under Condition monitoring, additional alarms can also be added as required. 

NOTE: It is important to note that in VibroSight Capture, any machinery protection system 
(MPS) information is displayed for information only and cannot be edited. 
In general, such information is displayed as being unavailable (that is, greyed out). 

However, all condition monitoring system (CMS) information can be freely edited in 
VibroSight Capture, as required by the user. 

 

 

2.3 VM600Mk2 MPC4Mk2 support for dual-channel rotor expansion (single taper) processing 

VibroSight 7.2.0 adds support for dual-channel Rotor expansion (single taper) processing and measurement, a 
dual-channel processing, when using the VM600Mk2 MPC4Mk2 + IOC4Mk2 module’s dynamic or auxiliary channels. 

NOTE: Dual-channel Rotor expansion (single taper) processing is similar to the existing 
support for dual-channel rotor expansion (collar) processing, except that it is 
designed for operation with single-taper shafts. 

 
More specifically, VibroSight Protect now allows “paired” VM600Mk2 MPC4Mk2 dynamic and/or auxiliary channels to 
be configured for dual-channel Rotor expansion (single taper) processing using proximity sensors / measurement 
chains on CH1-CH2, CH3-CH4 and/or AX1-AX2. 

In VibroSight Protect, when configuring dual-channel Rotor expansion (single taper) processing for machinery 
protection, it is necessary to configure a pair of dynamic or auxiliary channels for use with proximity sensors / 
measurement chains, such as the TQxxx/IQSxxx. First, click/select a dynamic or auxiliary measurement channel, 
then configure the pair of channels by selecting Processing type: Dual, Sensor family: Proximity probes, then Rotor 
expansion (single taper). 

Then, when prompted to configure the sensors / measurement chains (Configuration of a channel), for each of the 
two channels, use the Add control to select the proximity probe (and measurement chain) from the Library in order 
to use a sensor / measurement chain with default values. Alternatively, under the Library list, use the Add control to 
add a new sensor chain (vibro-meter or generic) to the list, or use the Duplicate and/or Edit controls to modify an 
existing sensor / measurement chain as required. 
Alternatively, the Copy from control can be used to re-use the configuration for a proximity sensor (and 
measurement chain) that is already configured for a different measurement channel. 
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In VibroSight Protect, when configuring dual-channel Rotor expansion (single taper) processing for machinery 
protection, it is important to note that: 

• Two proximity probes (sensors) are required. 

• A pair of dynamic (CH1-CH2 or CH3-CH4) or auxiliary (AX1-AX2) channels must be used. 

• For each channel, an initial gap must be configured (in mechanical (displacement) or electrical units) and the 
specifications of the taper (ramp angle) must also be configured. This is done on the Processing tab for the 
measurement channel. 

• A Range inverted control is available in order to be able to configure the direction/sense of the measurement 
output range. This is also on the Processing tab for the measurement channel. 

• Only a single quasi-static rotor expansion measurement (with alarms) is provided. 

 

In VibroSight Capture, when configuring dual-channel Rotor expansion (single taper) processing for condition 
monitoring, it is important to note that: 

• For the component/processing selected in the Machinery image (top), the name and type of measurement is 
displayed (bottom, left), while more detailed information for the associated processing and measurements is 
displayed (bottom, centre) across three tabs: General, Processing and Alarms. 

• The information displayed is a combination of: 

• The information imported from the associated machinery protection system (MPS) configuration, that is, the 
measurements (sensors / measurements chains, processing and alarms) imported from the 
VibroSight Protect configuration. 

• The default condition monitoring measurements (processing and alarms) that are automatically generated by 
VibroSight Capture, depending on the VibroSight Protect configuration. 

 

In general, on the Processing tab, under Condition monitoring, the default settings can be changed as required. On 
the Alarms tab, under Condition monitoring, additional alarms can also be added as required. 

NOTE: It is important to note that in VibroSight Capture, any machinery protection system 
(MPS) information is displayed for information only and cannot be edited. 
In general, such information is displayed as being unavailable (that is, greyed out). 

However, all condition monitoring system (CMS) information can be freely edited in 
VibroSight Capture, as required by the user. 
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2.4 VM600Mk2 MPC4Mk2 support for dual-channel rotor expansion (dual taper) processing 

VibroSight 7.2.0 adds support for dual-channel Rotor expansion (dual taper) processing and measurement, a dual-
channel processing, when using the VM600Mk2 MPC4Mk2 + IOC4Mk2 module’s dynamic or auxiliary channels. 

NOTE: Dual-channel Rotor expansion (dual taper) processing is similar to the existing 
support for dual-channel rotor expansion (collar) processing, except that it is 
designed for operation with dual-taper shafts. 

 
More specifically, VibroSight Protect now allows “paired” VM600Mk2 MPC4Mk2 dynamic and/or auxiliary channels to 
be configured for dual-channel Rotor expansion (dual taper) processing using proximity sensors / measurement 
chains on CH1-CH2, CH3-CH4 and/or AX1-AX2. 

In VibroSight Protect, when configuring dual-channel Rotor expansion (dual taper) processing for machinery 
protection, it is necessary to configure a pair of dynamic or auxiliary channels for use with proximity sensors / 
measurement chains, such as the TQxxx/IQSxxx. First, click/select a dynamic or auxiliary measurement channel, 
then configure the pair of channels by selecting Processing type: Dual, Sensor family: Proximity probes, then Rotor 
expansion (dual taper). 

Then, when prompted to configure the sensors / measurement chains (Configuration of a channel), for each of the 
two channels, use the Add control to select the proximity probe (and measurement chain) from the Library in order 
to use a sensor / measurement chain with default values. Alternatively, under the Library list, use the Add control to 
add a new sensor chain (vibro-meter or generic) to the list, or use the Duplicate and/or Edit controls to modify an 
existing sensor / measurement chain as required. 
Alternatively, the Copy from control can be used to re-use the configuration for a proximity sensor (and 
measurement chain) that is already configured for a different measurement channel. 

 
In VibroSight Protect, when configuring dual-channel Rotor expansion (dual taper) processing for machinery 
protection, it is important to note that: 

• Two proximity probes (sensors) are required. 

• A pair of dynamic (CH1-CH2 or CH3-CH4) or auxiliary (AX1-AX2) channels must be used. 

• For each channel, an initial gap must be configured (in mechanical (displacement) or electrical units) and the 
specifications of the tapers (ramp angles) must also be configured. This is done on the Processing tab for the 
measurement channel. 

• A Range inverted control is available in order to be able to configure the direction/sense of the measurement 
output range. This is also on the Processing tab for the measurement channel. 

• Only a single quasi-static rotor expansion measurement (with alarms) is provided. 

•  
In VibroSight Capture, when configuring dual-channel Rotor expansion (dual taper) processing for condition 
monitoring, it is important to note that: 

• For the component/processing selected in the Machinery image (top), the name and type of measurement is 
displayed (bottom, left), while more detailed information for the associated processing and measurements is 
displayed (bottom, centre) across three tabs: General, Processing and Alarms. 
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• The information displayed is a combination of: 

• The information imported from the associated machinery protection system (MPS) configuration, that is, the 
measurements (sensors / measurements chains, processing and alarms) imported from the 
VibroSight Protect configuration. 

• The default condition monitoring measurements (processing and alarms) that are automatically generated by 
VibroSight Capture, depending on the VibroSight Protect configuration. 

 

In general, on the Processing tab, under Condition monitoring, the default settings can be changed as required. On 
the Alarms tab, under Condition monitoring, additional alarms can also be added as required. 

NOTE: It is important to note that in VibroSight Capture, any machinery protection system 
(MPS) information is displayed for information only and cannot be edited. 
In general, such information is displayed as being unavailable (that is, greyed out). 

However, all condition monitoring system (CMS) information can be freely edited in 
VibroSight Capture, as required by the user. 

 

 

2.5 VM600Mk2 MPC4Mk2 support for dual-channel shaft axial position (collar) processing 

VibroSight 7.2.0 adds support for dual-channel Shaft axial position (collar) processing and measurement, a dual-
channel processing, when using the VM600Mk2 MPC4Mk2 + IOC4Mk2 module’s dynamic channels. 

NOTE: Dual-channel Shaft axial position (collar) processing is similar to the existing 
support for single-channel Shaft axial position (collar) processing, except that the 
dual-channel method incorporates 2oo2 (2-out-of-2) voting logic, such that the 
dual-channel axial position measurement is the average of the two corresponding 
single-channel axial position measurements and the dual-channel data flags are 
the logical OR of the two corresponding single-channel data flags. 

 
More specifically, VibroSight Protect now allows “paired” VM600Mk2 MPC4Mk2 dynamic channels to be configured 
for dual-channel Shaft axial position (collar) processing using proximity sensors / measurement chains on 
CH1-CH2 and/or CH3-CH4. 

In VibroSight Protect, when configuring dual-channel Shaft axial position (collar) processing for machinery 
protection, it is necessary to configure a pair of dynamic channels for use with proximity sensors / measurement 
chains, such as the TQxxx/IQSxxx. First, click/select a dynamic measurement channel, then configure the pair of 
channels by selecting Processing type: Dual, Sensor family: Proximity probes, then Shaft axial position (collar). 

Then, when prompted to configure the sensors / measurement chains (Configuration of a channel), for each of the 
two channels, use the Add control to select the proximity probe (and measurement chain) from the Library in order 
to use a sensor / measurement chain with default values. Alternatively, under the Library list, use the Add control to 
add a new sensor chain (vibro-meter or generic) to the list, or use the Duplicate and/or Edit controls to modify an 
existing sensor / measurement chain as required. 
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Alternatively, the Copy from control can be used to re-use the configuration for a proximity sensor (and 
measurement chain) that is already configured for a different measurement channel. 

 
In VibroSight Protect, when configuring dual-channel Shaft axial position (collar) processing for machinery 
protection, it is important to note that: 

• Two proximity probes (sensors / measurement chains) are required. 

• A pair of dynamic (CH1-CH2 or CH3-CH4) channels must be used. 

• For each channel, an initial gap must be configured (in mechanical (displacement) or electrical units). This is 
done on the Processing tab for the measurement channel. 

• A Range inverted control is available in order to be able to configure the direction/sense of the measurement 
output range. This is also on the Processing tab for the measurement channel. 

• Only a single shaft axial position measurement (with alarms) is provided. 

NOTE: The dual-channel Shaft axial position (collar) processing incorporates 2oo2 voting 
logic, such that the axial position measurement provided is the average of the two 
corresponding single-channel axial position measurements (and the data flags are 
the logical OR of the two corresponding single-channel data flags). 

 

In VibroSight Capture, when configuring dual-channel Shaft axial position (collar) processing for condition 
monitoring, it is important to note that: 

• For the component/processing selected in the Machinery image (top), the name and type of measurement is 
displayed (bottom, left), while more detailed information for the associated processing and measurements is 
displayed (bottom, centre) across three tabs: General, Processing and Alarms. 

• The information displayed is a combination of: 

• The information imported from the associated machinery protection system (MPS) configuration, that is, the 
measurements (sensors / measurements chains, processing and alarms) imported from the 
VibroSight Protect configuration. 

• The default condition monitoring measurements (processing and alarms) that are automatically generated by 
VibroSight Capture, depending on the VibroSight Protect configuration. 

 

In general, on the Processing tab, under Condition monitoring, the default settings can be changed as required. On 
the Alarms tab, under Condition monitoring, additional alarms can also be added as required. 

NOTE: It is important to note that in VibroSight Capture, any machinery protection system 
(MPS) information is displayed for information only and cannot be edited. 
In general, such information is displayed as being unavailable (that is, greyed out). 

However, all condition monitoring system (CMS) information can be freely edited in 
VibroSight Capture, as required by the user. 
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2.6 Range inverted control for VM600Mk2 MPC4Mk2 position-based processings 

VibroSight 7.2.0 ensures that a Range inverted control is now available for VM600Mk2 MPC4Mk2 + IOC4Mk2 module 
position-based processings, notably those using collars, pendulums, shaft ends or tapers (single or dual). 

The Range inverted control allows the direction/sense of the measurement output range to be configured 
depending on user preferences. 
In general, the Range inverted control is available on the Processing tab for the measurement channel 
(VibroSight Protect). By default, the Range inverted control is not selected. 
 
Example: 
A position-based processing using a TQ902/IQS900 sensor / measurement chain has a default measurement 
range of 0.15 to 2.15 mm. 
However, with the Range inverted control selected, the measurement range becomes −0.15 to −2.15 mm. 
 

 

2.7 Channel associations for VM600Mk2 MPC4Mk2 dual-channel position-based processings 

In VibroSight 7.2.0, the user interfaces for VM600Mk2 MPC4Mk2 + IOC4Mk2 module dual-channel position-based 
processings have been improved in order to more clearly identify which channel is associated with which part of the 
shaft, to make it easier to change/swap the channels (sensor / measurement chain) associated with each part of 
the shaft, and to see how the Range inverted control affects the direction/sense of the measurement. 

The improved user interfaces affect the following dual-channel processings: 
Differential expansion (collar), Differential expansion (single taper) and Differential expansion (dual taper), 
Rotor expansion (collar), Rotor expansion (single taper) and Rotor expansion (dual taper). 

The updated user interfaces can be found on the Processing tab for the dual-channel measurements, above the 
individual channels (VibroSight Protect). 

This improved channel association makes it easier to understand the physical arrangement of sensors / 
measurement chains (channels) on the machinery being monitored, resulting in easier installation, configuration 
and diagnosis of systems. 

 

 

2.8 VM600Mk2 MPC4Mk2 support for delta quasi-static temperature processing 

VibroSight 7.2.0 adds support for Delta quasi-static temperature processing and measurement, a dual-channel 
processing, when using the VM600Mk2 MPC4Mk2 + IOC4Mk2 module’s dynamic or auxiliary channels. 

NOTE: Delta quasi-static temperature processing is similar to the existing support for 
quasi-static temperature processing, except that the delta method uses two 
temperature measurement channels and subtracts one measurement from the 
other in order to directly provide the difference (delta) between the temperature 
measurements. 
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More specifically, VibroSight Protect now allows “paired” VM600Mk2 MPC4Mk2 dynamic and/or auxiliary channels to 
be configured for Delta quasi-static temperature processing using temperature sensors / measurement chains on 
CH1-CH2, CH3-CH4 and/or AX1-AX2. 

In VibroSight Protect, when configuring Delta quasi-static temperature processing for machinery protection, it is 
necessary to configure a pair of dynamic or auxiliary channels for use with temperature sensors / measurement 
chains. First, click/select a dynamic or auxiliary measurement channel, then configure the pair of channels by 
selecting Processing type: Dual, Sensor family: Temperature sensors, then Delta quasi-static temperature. 

Then, when prompted to configure the sensors / measurement chains (Configuration of a channel), for each of the 
two channels, use the Add control to select the temperature sensor (and measurement chain) from the Library in 
order to use a sensor / measurement chain with default values. Alternatively, under the Library list, use the Add 
control to add a new sensor chain (vibro-meter or generic) to the list, or use the Duplicate and/or Edit controls to 
modify an existing sensor / measurement chain as required. 
Alternatively, the Copy from control can be used to re-use the configuration for a temperature sensor (and 
measurement chain) that is already configured for a different measurement channel. 

 
In VibroSight Protect, when configuring Delta quasi-static temperature processing for machinery protection, it is 
important to note that: 

• Two temperature sensors / measurement chains are required. 

• A pair of dynamic (CH1-CH2 or CH3-CH4) or auxiliary (AX1-AX2) channels must be used. 

• For each channel, a temperature offset must be configured (in temperature units). This is done on the 
Processing tab for the measurement channel. 

• Only a single delta quasi-static temperature measurement (with alarms) is provided. 

 

In VibroSight Capture, when configuring Delta quasi-static temperature processing for condition monitoring, it is 
important to note that: 

• For the component/processing selected in the Machinery image (top), the name and type of measurement is 
displayed (bottom, left), while more detailed information for the associated processing and measurements is 
displayed (bottom, centre) across three tabs: General, Processing and Alarms. 

• The information displayed is a combination of: 

• The information imported from the associated machinery protection system (MPS) configuration, that is, the 
measurements (sensors / measurements chains, processing and alarms) imported from the 
VibroSight Protect configuration. 

• The default condition monitoring measurements (processing and alarms) that are automatically generated by 
VibroSight Capture, depending on the VibroSight Protect configuration. 
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In general, on the Processing tab, under Condition monitoring, the default settings can be changed as required. On 
the Alarms tab, under Condition monitoring, additional alarms can also be added as required. 

NOTE: It is important to note that in VibroSight Capture, any machinery protection system 
(MPS) information is displayed for information only and cannot be edited. 
In general, such information is displayed as being unavailable (that is, greyed out). 

However, all condition monitoring system (CMS) information can be freely edited in 
VibroSight Capture, as required by the user. 

 

 

2.9 VM600Mk2 MPC4Mk2 support for delta quasi-static pressure processing 

VibroSight 7.2.0 adds support for Delta quasi-static pressure processing and measurement, a dual-channel 
processing, when using the VM600Mk2 MPC4Mk2 + IOC4Mk2 module’s dynamic or auxiliary channels. 

NOTE: Delta quasi-static pressure processing is similar to the existing support for quasi-
static pressure processing, except that the delta method uses two pressure 
measurement channels and subtracts one measurement from the other in order to 
directly provide the difference (delta) between the pressure measurements. 

 
More specifically, VibroSight Protect now allows “paired” VM600Mk2 MPC4Mk2 dynamic and/or auxiliary channels to 
be configured for Delta quasi-static pressure processing using pressure sensors / measurement chains on 
CH1-CH2, CH3-CH4 and/or AX1-AX2. 

In VibroSight Protect, when configuring Delta quasi-static pressure processing for machinery protection, it is 
necessary to configure a pair of dynamic or auxiliary channels for use with pressure sensors / measurement 
chains. First, click/select a dynamic or auxiliary measurement channel, then configure the pair of channels by 
selecting Processing type: Dual, Sensor family: Pressure sensors, then Delta quasi-static pressure. 

Then, when prompted to configure the sensors / measurement chains (Configuration of a channel), for each of the 
two channels, use the Add control to select the pressure sensor (and measurement chain) from the Library in order 
to use a sensor / measurement chain with default values. Alternatively, under the Library list, use the Add control to 
add a new sensor chain (vibro-meter or generic) to the list, or use the Duplicate and/or Edit controls to modify an 
existing sensor / measurement chain as required. 
Alternatively, the Copy from control can be used to re-use the configuration for a pressure sensor (and 
measurement chain) that is already configured for a different measurement channel. 

In VibroSight Protect, when configuring Delta quasi-static pressure processing for machinery protection, it is 
important to note that: 

• Two pressure sensors / measurement chains are required. 

• A pair of dynamic (CH1-CH2 or CH3-CH4) or auxiliary (AX1-AX2) channels must be used. 

• For each channel, a pressure offset must be configured (in pressure units). This is done on the Processing tab 
for the measurement channel. 

• Only a single delta quasi-static pressure measurement (with alarms) is provided. 
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In VibroSight Capture, when configuring Delta quasi-static pressure processing for condition monitoring, it is 
important to note that: 

• For the component/processing selected in the Machinery image (top), the name and type of measurement is 
displayed (bottom, left), while more detailed information for the associated processing and measurements is 
displayed (bottom, centre) across three tabs: General, Processing and Alarms. 

• The information displayed is a combination of: 

• The information imported from the associated machinery protection system (MPS) configuration, that is, the 
measurements (sensors / measurements chains, processing and alarms) imported from the 
VibroSight Protect configuration. 

• The default condition monitoring measurements (processing and alarms) that are automatically generated by 
VibroSight Capture, depending on the VibroSight Protect configuration. 

 

In general, on the Processing tab, under Condition monitoring, the default settings can be changed as required. On 
the Alarms tab, under Condition monitoring, additional alarms can also be added as required. 

NOTE: It is important to note that in VibroSight Capture, any machinery protection system 
(MPS) information is displayed for information only and cannot be edited. 
In general, such information is displayed as being unavailable (that is, greyed out). 

However, all condition monitoring system (CMS) information can be freely edited in 
VibroSight Capture, as required by the user. 

 

 

2.10 Improved sensor catalog support for the GSI127 

The sensor catalog used by the VibroSight software for the configuration of the inputs to a machinery monitoring 
system such as a VM600Mk2 MPC4Mk2 + IOC4Mk2 module has improved how information related to 
sensors / measurement chains using a GSI127 galvanic separation unit is handled and presented in order to help 
reduce external wiring errors. 

In general, depending on the sensor / measurement chain using a GSI127 galvanic separation unit, the output 
signal from the GS127 can be connected to the input of a IOC4Mk2 module in one of two ways: 

• GSI127 O/P  IOC4Mk2 HI  and  GSI127 0 V  IOC4Mk2 LO, that is, non-inverted. 

• GSI127 O/P  IOC4Mk2 LO  and  GSI127 0 V  IOC4Mk2 HI, that is, inverted. 

 

Accordingly, now in the sensor catalog, when the information related to a sensor / measurement chain using a 
GSI127 galvanic separation unit is presented, below the GSI127, the following information is displayed: 

• Transfer function (sensitivity) of the particular GSI127 used. 
For example, 1 V/mA for a GSI127 with ordering option code B02 as typically used by a IPC707 signal 
conditioner, −1 V/V for a GSI127 with ordering option code B05 as typically used by a IQS900 signal 
conditioner. 
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• A tooltip that can be used to highlight the wiring required between the GSI127 and IOC4Mk2, that is, non-
inverted or inverted. 

NOTE: The sensor / measurement chain wiring diagrams in the relevant installation 
manual also provide detailed information on the wiring required between 
sensors / measurement chains and machinery monitoring systems. 

 

In VibroSight Protect, the Tools > Global sensors catalog command is used to access and work with the 
sensors / measurement chains used as inputs to VM600Mk2 MPC4Mk2 + IOC4Mk2 modules. 

 

 

2.11 Improved tachometer functionality 

The functionality of the VM600Mk2 MPC4Mk2 + IOC4Mk2 module’s auxiliary channels, when used as tachometers, has 
been improved such that they can now be configured and used as follows: 

• For use with one or two shafts. 
That is, each auxiliary channel, when used as a tachometer, can be configured for operation with one shaft 
(Single shaft) or two shafts (Dual shaft) – providing up to two speed measurement outputs per tachometer 
channel. 
(Previously, the tachometers were effectively capable of operation with one shaft (single shaft) only – providing 
a single speed measurement output per channel.) 

• With configurable tacho ratios. 
That is, for each auxiliary channel used as a tachometer, a tacho ratio (Conversion ratio) can be individually 
configured for each speed measurement output. 
(Previously, the tachometers were effectively capable of operation with a fixed, default tacho ratio of 1:1.) 

 

In VibroSight Protect, when configuring an auxiliary channel as a tachometer (on the Configure tab/page), with the 
channel selected, the Processing tab now allows Number of shafts to be configured as either Single shaft or 
Dual shaft, as required. 

Note: The default Number of shafts is Single shaft. 

 

While for each speed measurement output (one for Single shaft and two for Dual shaft), a Conversion ratio 
(tacho ratio) in terms of two integers between 1 and 60000 can be configured, as required. 

Note: The default Conversion ratio (tacho ratio) is 1:1. 

 

Further, in VibroSight Capture, when connecting measurement channels to machine train components (on the 
Connect tab/page), for a tachometer configured for operation with two shafts (Dual shaft), both speed 
measurements (individually identifiable by measurement name) are available so that they can be connected to 
different parts of the machine train. For example, to the input and output shafts of a gearbox. 
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This improved tachometer functionality makes it easier to configure VM600Mk2-based systems to monitor and 
protect systems including components such as gearboxes, belts, chains, pulleys, etc. 

 

 

2.12 Improved diagnostic file handing 

In most VibroSight software modules, the Help > Save diagnostic information … command is used to save 
diagnostic information about the VibroSight software running on a particular computer to a VibroSight 
diagnostic information file (*.zip). 

VibroSight diagnostic information files contain important information about the operation of an installation/system 
that can be shared with Meggitt Customer support and/or Engineering to help diagnose problems experienced in 
the field. 

Improved handling of diagnostic information by VibroSight now results in dramatically reduced waiting times for 
users and ultimately, improved customer support. 

(Previously, the VibroSight diagnostic information file (*.zip) also included information about Windows events 
(application, security, etc.) which dramatically increased the time required to save a diagnostic file. For example, 
times greater than 30 minutes were not uncommon.) 

 

 

2.13 Changes to the logging of events 

Starting with VibroSight 7.2.0, all alarms and events for a system will automatically be logged into the VibroSight 
database as long as data logging is enabled in the VibroSight Server. That is, it is only necessary to ensure that the 
Server Features – Data logging manager control is enabled on the Status tab/page of the VibroSight Server in 
order for the logging of events to occur. 

 

(For reference, earlier versions of VibroSight required that event logging was explicitly configured for the logging of 
events to occur. For example, in VibroSight Configurator, when creating a VibroSight Server configuration, in the 
Data storage view, under Data logging, Events storage groups and Events logging rules had to be added and 
configured in order to define which specific events to log, as required. 
Please note that in VibroSight Configurator, the Events storage groups and Events logging rules have now been 
removed as they are no longer required.) 
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VM600Mk2 modules 

2.14 MPC4Mk2 + IOC4Mk2 module – hardware 

Due to the ongoing global electronic components shortage, it has become necessary to create a new version of the 
VM600Mk2 MPC4Mk2 + IOC4Mk2 machinery protection and condition monitoring module. 

More specifically, there will soon be two versions of the MPC4Mk2 module available and in use: 

• PNR 600-041-000-vvv – which uses an automotive grade Xilinx Zynq SoC (system-on-chip) processor. 
This is the original version which has been provided to customers up until now. 

• PNR 600-041-001-vvv – which uses an industrial grade Xilinx Zynq SoC processor. 
This is the new version which will soon be provided to customers. 

Both versions of the MPC4Mk2 module (PNRs 600-041-000-vvv and 600-041-001-vvv) are fully compatible with the 
same specifications and features, that is, they are form, fit and functionally equivalent modules. While one version 
of the module uses an automotive grade processor and the other uses its industrial grade equivalent, both versions 
have exactly the same operating and storage temperature ranges so there is no impact on customers or end users. 

It is important to note that this new version of the MPC4Mk2 module (PNR 600-041-001-vvv) is foreseen as a 
temporary measure with a planned production of approximately 1600 modules – required in order to meet the 
ongoing high demand for VM600Mk2 solutions. 

 

NOTE: The original version of the MPC4Mk2 module (PNR 600-041-000-001) is no longer 
supported, so it is not compatible with the latest versions of firmware. For example, 
the machinery protection firmware (640-025-007-001). 
See also 7.2.1 VM600Mk2/VM600 module/card firmware. 
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2.15 MPC4Mk2 + IOC4Mk2 module – firmware 

Updated VM600Mk2 MPC4Mk2 + IOC4Mk2 machinery protection and condition monitoring module firmware with the 
following main improvements: 

 

Machinery protection firmware: 640-025-007-001 

NOTE: VM600Mk2 MPC4Mk2 machinery protection firmware (640-025-007-001) is 
compatible with both versions of the MPC4Mk2 module (PNRs 600-041-000-vvv and 
600-041-001-vvv). However, it is important to note that, depending on the version 
of MPC4Mk2 module hardware, the firmware upgrade path is different: 

• For earlier versions of MPC4Mk2 module PNR 600-041-000-002 (with an 
automotive grade Xilinx Zynq SoC processor), upgrading to the 
640-025-007-001 machinery protection firmware is only possible from the 
640-025-006-000 machinery protection firmware. 
That is, modules with 640-025-005-000 firmware or older will first have to be 
upgraded to the 640-025-006-000 firmware, then upgraded to the 
640-025-007-001 firmware (a two-step process). 

• For later versions of MPC4Mk2 module PNR 600-041-001-002 (with an industrial 
grade Xilinx Zynq SoC processor), upgrading to the 640-025-007-001 machinery 
protection firmware is a simple one-step process. 
This is because MPC4Mk2 module PNR 600-041-001-002 is a new module and so 
is thus far only available and compatible with the 640-025-007-001 firmware. 

See also Recovery firmware: 640-031-005-001 (below). 

 

Features: 

• Support for industrial grade processor (Xilinx Zynq SoC (system-on-chip) processor). 

• Faster code execution and updated operating system. 

• Tacho gear ratio support. 

• Low-pass (LP) filter supports 120 dB/octave. 

• Improved LED behaviour. 

• CPUMMk2 alarm reset accepted when locked. 

• Reboot delay depends on rack slot number. 

• Additional signal processing: Single-channel Rotor expansion (pendulum), Dual-channel Rotor expansion 
(single taper), Dual-channel Rotor expansion (dual taper), Delta quasi-static pressure, Delta quasi-static 
temperature, Dual-channel Shaft axial position (collar). 
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Bug fixes: 

• Analog output no longer updated during stabilisation time period (when module first enters the Operational 
mode). 

• Module no longer goes into Fail-safe mode when a configuration with incorrect slot identifier is sent. 

• Alarm events are no longer incorrectly generated when an alarm is configured as latched. 

• Analog output current no longer becomes imprecise with higher loads. 

• Module always restarts after a power cycle. 

Restrictions: 

• Only compatible with condition monitoring firmware 640-033-003-000. 

• Only compatible with VibroSight 7.2. 

• Only compatible with VM600Mk2 CPUMMk2 + IOCNMk2 firmware 640-033-003-000. 

 

 

Condition monitoring firmware: 640-033-003-000 

Features: 

• Faster code execution. 

• Tacho gear ratio support. 

• Low-pass (LP) filter supports 120 dB/octave. 

Restrictions: 

• Only compatible with machinery protection firmware 640-025-007-001. 
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Recovery firmware: 640-031-005-001 

NOTE: Upgrading to the 640-031-005-001 recovery firmware is only possible from the 
640-025-007-001 machinery protection firmware. 
That is, modules with 640-025-006-000 machinery protection firmware or older will 
first have to be upgraded to the 640-025-007-001 machinery protection firmware, 
then upgraded to the 640-031-005-001 recovery firmware. 

See also Machinery protection firmware: 640-025-007-001 (above). 

 

Features: 

• Support for industrial grade processor (Xilinx Zynq SoC (system-on-chip) processor). 

Restrictions: 

• Only compatible with proof test firmware 640-032-003-000. 

• Only compatible with VibroSight 7.2. 

 

Proof test firmware: 640-032-003-000 

Bug fixes: 

• Proof test no longer incorrectly passes if IOC4Mk2 module’s hardware PNR is not detected. 

• Proof test’s DC redundant test now works for values close to zero. 

Restrictions: 

• Only compatible with recovery firmware 640-031-005-001. 

 

See also 6.2 VM600Mk2/VM600 modules/cards. 

 

 

2.16 CPUMMk2 + IOCNMk2 module 

Updated VM600Mk2 CPUMMk2 + IOCNMk2 rack controller and communications interface firmware with the following 
main improvements: 

Base-system / applications firmware: 640-034-003-000 

Restrictions: 

• Only compatible with VM600Mk2 MPC4Mk2 + IOC4Mk2 machinery protection firmware 640-025-007-001. 

 

See also 6.2 VM600Mk2/VM600 modules/cards. 
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3 Important announcement concerning future versions of VibroSight 

3.1 VibroSight software and support for OPC HDA 

Please note that due to planned changes to the Microsoft .NET Framework – which are out of our control – it will 
soon no longer be possible for the VibroSight software to support OPC HDA (historical data access, part of 
OPC Classic). 

As a result of these changes and for commercial reasons, it has been decided to remove VibroSight’s support for 
OPC Classic servers (OPC DA (data access, “live” data) and OPC HDA) by the end of 2023. 

Please note that VibroSight will continue to support OPC Classic clients (allowing the import of data into a 
VibroSight database) and OPC UA, as before. 

Accordingly, it is recommended that customers who rely on VibroSight’s support for OPC Classic servers (OPC DA 
and OPC HDA) contact Alfonso Fernandez, Product Owner, VibroSight, in a timely manner to discuss alternative 
solutions. 

 

 

 

  

mailto:alfonso.fernandez@ch.meggit.com?subject=VibroSight's%20support%20for%20OPC%20HDA
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4 Solved problems and bug fixes 

4.1 General improvements and bug fixes 

General stability improvements and bug fixes across the VibroSight 7.2.0 software. 

 

4.2 VibroSight Vision not displaying hydro air-gap eccentricity measurements correctly 

In VibroSight Vision, when using a Polar Waveform plot to display eccentricity measurements from a VibroSmart-
based hydro air-gap monitoring system, the measurement data was displayed incorrectly, characterised by 
inconsistent/unstable plots with some poles/probes missing, and many plots flagged as containing bad quality data. 

 

4.3 VibroSight Server not running properly after hydro air-gap configuration changes 

When working with systems containing a hydro air-gap and flux processing block, the VibroSight Server would stop 
running (crash) after changes were made to the hydro air-gap configuration (for example, disabling a data entity 
such as a layer stator eccentricity) in VibroSight Configurator and the Air-Gap server features (processing) were re-
enabled in the VibroSight Server. 

 

4.4 VibroSight Protect not opening configurations created with earlier versions 

With VibroSight 7.1.x, VibroSight Protect would not open certain machinery protection configurations (that is, 
Protect files (*.mpscfg)) created using earlier versions of VibroSight Protect, specifically, configurations containing a 
relay for which no input had been defined. 

 

4.5 VibroSight Protect not saving configurations for systems containing modules with 
incompatible firmware 

With VibroSight 7.1.0, VibroSight Protect, having activated a configuration containing a VM600Mk2 MPC4Mk2 module 
and a CPUMMk2 module but with firmware versions older then the versions provided with VibroSight 7.1.0, and then 
re-connecting to the system just configured, VibroSight Protect would no longer save the machinery protection 
configuration (that is, Protect files (*.mpscfg)). 

 

4.6 VibroSight Protect not activating configurations using lowercase serial numbers 

In VibroSight Protect, when activating a configuration containing a VM600Mk2 MPC4Mk2 module whose 
Serial number contains lowercase characters (for example, as01234 instead of AS01234), the software would not 
activate the configuration but reported an error. 

NOTE: Later versions of VibroSight Protect only allow Serial numbers containing 
uppercase characters to be entered (for example, AS01234 instead of as01234). 
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4.7 VibroSight Protect allowing logical functions with direct connections between inputs and 
second-level logic gates 

In VibroSight Protect, when working with Logical functions, it was possible to make a direct connection between 
Inputs and logic gates in the Second level conditions. 

NOTE: VibroSight Protect now only allows direct connection between Inputs and logic 
gates in the First level conditions, and logic gates in the First level conditions and 
logic gates in the Second level conditions. 

 

It is no longer possible to create direct connection between Inputs and logic gates in the Second level conditions, 
and configurations containing such connections will be detected and reported by the consistency checker. 

 

4.8 VibroSight Protect not configuring/connecting to systems containing MPC4Mk2 modules with 
incompatible firmware 

In VibroSight Protect, when activating a configuration containing multiple VM600Mk2 MPC4Mk2 modules but with 
different firmware versions actually runnning on the modules, the Dashboard tab/page would keep displaying the 
system status as “Connecting” even though one or more modules had incompatible firmware and could neither be 
connected to or configured. 

Starting with VibroSight 7.2, VibroSight Protect now detects incompatible firmware and will inform the user via a 
warning message, as required. 

 

4.9 Bus View’s Route via OC bus control not working in VibroSight Protect 

In VibroSight Protect, when working with the Bus View (on the Dashboard tab/page), after a Route via Raw bus 
control is used in an OC bus to change the sharing of a signal from an OC bus to the Raw bus, the corresponding 
Route via OC bus control in the Raw bus could not be used to change the sharing of a signal from the Raw bus to 
an OC bus (as the link to the action/functionality behind the control was broken). 

 

4.10 VibroSight System Manager not changing firmware on multiple MPC4Mk2 modules in 
parallel 

When VibroSight System Manager was being used to change the firmware on multiple VM600Mk2 MPC4Mk2 
modules in parallel (that is, at the same time) – by selecting one or more modules in the System Explorer window, 
Devices view, before running the Change firmware command (Actions window) – the upgrade(s) would fail with the 
firmware upgrade window/wizard stuck showing: 

Upgrading firmware on the module(s): Finished 
Waiting for the firmware to be installed: In progress 
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4.11 Problems copying/exporting from VibroSight databases containing orbits 

In VibroSight Capture, when using File Storage operations (on the Data tab/page) to copy/export data from a 
VibroSight Server (*.vshdf) to a VibroSight historical data archive (*.vshda), if the data to be copied includes orbits 
and some of the orbits are corrupt (typically due to the VibroSight Server not being closed correctly), then the Filt 
storage copy operation can fail with the result that the historical data archive (*.vshda) is not created. 
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5 Known issues 

5.1 Security risks 

A number of Open web application security project (OWASP) security risks have been identified related to a 
UPC UA library used by the VibroSight software. This UPC UA library is from a third-party (Softing AG, Softing 
Industrial Automation GmbH), who have recently implemented a fix. However the improved UPC UA library is not 
included in the latest release of VibroSight (VibroSight 7.2). 

For information, the specific issues that have been identified are: 

• CVE-2022-29862: An infinite loop in OPC UA .NET Standard Stack 1.04.368 allows a remote attackers to 
cause the application to hang via a crafted message 

• CVE-2022-29863: OPC UA .NET Standard Stack 1.04.368 allows remote attacker to cause a crash via a 
crafted message that triggers excessive memory allocation. 

• CVE-2022-29864: OPC UA .NET Standard Stack 1.04.368 allows a remote attacker to cause a server to crash 
via a large number of messages that trigger Uncontrolled Resource Consumption. 

• CVE-2022-29865 : OPC UA .NET Standard Stack 1.04.368 allows a remote attacker to bypass the application 
authentication check via crafted fake credentials 

• CVE-2022-29866: OPC UA .NET Standard Stack 1.04.368 allows a remote attacker to exhaust the memory 
resources of a server via a crafted request that triggers Uncontrolled Resource Consumption. 

 

5.2 Display of timestamps in VibroSight Vision 

In VibroSight Vision, when the timestamps (date and time) are configured to be displayed as Site time or Local 
computer time and the site time or local computer time is subsequently changed on the relevant computer (for 
example, using Windows > Control Panel > Date and Time), this change is not reflected in the VibroSight Vision 
user interface until the user clicks on the Timestamp displayed in the VibroSight Vision status bar. 

 

5.3 VibroSight Server and Host Service restart required after changes to network adapter 

If the configuration of a network adapter is changed (for example, enabled or disabled, connected or disconnected) 
on a computer running VibroSight, then the VibroSight Servers and Host Services running on the computer must 
be restarted in order for the network adapter to be recognized by the VibroSight discovery mechanism. 

 

5.4 Length limitation of VibroSight Server instance names 

Since VibroSight 2.9.6, VibroSight Server instance names are limited to 18 characters, whereas up to 
27 characters were allowed in previous versions. This constraint is enforced during the creation of new server 
instances with VibroSight 2.9.6 or later. 
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NOTE: VibroSight allows only alphanumeric characters (A to Z, a to z, 0 to 9), the 
hyphen-minus character ( - ) and the underscore character ( _ ) to be used for 
VibroSight Server names. 

However, existing server instances may be non-compliant (too long) and no longer run after an upgrade of the 
VibroSight software. In such cases, the file names used for a VibroSight Server database file (*.vssrvdb or *.db) 
and a VibroSight Server configuration file (*.vssrvcfg or *.config) should be updated (and manually edited in the 
VibroSight configuration file) to be 18 characters or less. Changes may also be required in any VibroSight software 
that references the server instance name, such as VibroSight Vision projects. 

Where used, the automated data management commands and operations that append a timestamp 
(_yyyyMMddHHmmss) to the Server instance name reduces the number of file name characters that remain 
available for VibroSight Server instance names to three. Alternatively, the server instance name can be shorted 
after the data repository command or operation is complete. 

Also, depending on the VibroSight Server data repository (database) file names used and any truncation performed 
by VibroSight, it is possible that servers are created with names that contain non-allowed characters (such as 
spaces), with the result that these servers will not be accessible by VibroSight software clients. Similarly, duplicate 
VibroSight Server names are also possible. 

NOTE: Choose appropriate VibroSight Server names in order to avoid name conflicts 
arising due to truncation and/or additional data repositories being created during 
automatic data management. 

This is particularly important for systems with automated data management and 
system backup procedures that can generate VibroSight Server data repositories 
with different file names. 

 

5.5 Display of timestamps in VibroSight clients other than VibroSight Vision 

Although VibroSight Vision now supports the display of timestamps (date and time) as either Site time, UTC time or 
Local computer time, all other VibroSight client software modules continue to display timestamps in local computer 
time only (that is, the date and time according to the local clock of the computer running the VibroSight software 
module). 

 

5.6 Display of devices in VibroSight System Manager 

In the System Explorer window of VibroSight System Manager, the Devices tree-view does not always update 
correctly to show all of the devices (VM600 modules/cards and VibroSmart devices) available on the network. 

In particular, this has been seen when changing the firmware of a device, and can persist even after a refresh 
(using the Refresh toolbar button or View > Refresh). 

If this behaviour is seen, the recommended workaround is to: 

• Wait a few minutes and refresh again. 

• Restart VibroSight System Manager. 
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5.7 VibroSight Mimic backwards compatibility 

VibroSight 2.10.0 contained significant improvements and changes, including a separate VibroSight Mimic client 
software module for mimics (that were previously available in VibroSight Vision). As a result, VibroSight Vision 
mimics created with VibroSight 2.9.7 or earlier are not compatible with VibroSight 2.10.0 or later. 

VibroSight 2.11.0 contained significant improvements and changes to the VibroSight Mimic client software module. 
As a result, VibroSight Vision mimics created with VibroSight 2.10.1 or earlier are not compatible with VibroSight 
2.11.0 or later. 

VibroSight 2.11.5 contained significant improvements to the VibroSight Mimic project framework to include version 
information, in order to improve the compatibility between projects created with different versions of VibroSight 
Mimic and eliminate the requirement for the recreation of Mimics. Starting with VibroSight 2.11.5, Mimic projects 
automatically detect any changes in the VibroSight Mimic software that affect project compatibility, inform the user 
and update the project as required. 

 

NOTE: VibroSight 2.11.5 is also able to open and work with Mimic projects created with 
VibroSight 2.11.0 or later, if the corresponding database had been updated as 
required. 

 

NOTE: When updating existing machinery monitoring projects created with 
VibroSight 2.12.x to VibroSight 3.x.x or later, a new data repository created by 
copying a VibroSight database (*.vssrvdb) to a VibroSight historical data folder 
(*.vshdf) must use the same server file name as the existing server in order for 
existing VibroSight Mimics to maintain links with the data repository and continue to 
work (without manual corrections). 
In addition, the VibroSight Server using the new data repository must be running 
before the existing VibroSight Mimics are run for the first time, after the update. 

 

5.8 VibroSight OPC Clients not recovering 

When a VibroSight OPC Client is being used to import information from an external OPC server into a VibroSight 
system and the external OPC server becomes unavailable, the VibroSight OPC Client may not always recover 
automatically when the OPC server becomes available again. 

This is typically characterised by the VibroSight OPC Client continuing to show connection error messages even 
when OPC server is available and can result in permanent loss of the imported data if not noticed. 

NOTE: The external OPC data can be permanently lost if it is not imported into VibroSight 
as expected. 

Any VibroSight system feature or configuration element relying on the imported 
OPC data will not behave as expected, for example, alarms, machinery operating 
conditions and data logging rules. 
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If this behaviour is seen, the recommended workaround is to: 

• Stop and restart the VibroSight OPC Client from either the VibroSight Server 
(Data > Acquisition > OPC Device Driver) or VibroSight System Manager. 

• Stop and restart the VibroSight Server, if required. 

 

5.9 Duplicate events 

For VibroSight systems using VM600 XMx16 cards, VibroSight Event Viewer retrieves all of the event information 
available from the data buffers on the cards. 

For VibroSight systems using VibroSmart modules, VibroSight Event Viewer retrieves the event information 
available from the current time only (no buffered events). 

Accordingly, for a VibroSight system using VM600 XMx16 cards, there is the possibility of duplicate events being 
listed in the Event Viewer, particularly for VibroSight systems being operated without an NTP server (where events 
are not recognised as duplicates due to time drift). 

 

5.10 VibroSight Server status indicators 

The status indicators (performance counter monitors) on the Status tab of the new VibroSight Server are not 
correctly displayed and updated when an NVIDIA WMI driver is installed on the same computer as the VibroSight 
Server. 

NOTE: The NVIDIA Enterprise Management Toolkit (NVWMI) is a graphics and display 
management and control technology that interfaces to Microsoft’s Windows 
Management Instrumentation (WMI) infrastructure, specific to NVIDIA graphics 
processing units (GPUs). 

 

This is because NVIDIA WMI prevents the Microsoft .NET Framework from obtaining the required counter values 
from the underlying operating system / computer. 

 

5.11  XMx16 card pre-logging 

For an XMx16 card pair, if Dynamic Input Channel 16 is used as an input to a Dynamic Processing Block that is 
used as an input to a Dual Shaft Relative Processing Block which is configured to provide an Orbit and/or Full 
Spectrum output, then any pre-logging configured for the principal mode Waveform and/or Spectrum of Dynamic 
Input Channel 16 will not actually log any of the data from the same pre-logging scope. 

 

5.12  Problems creating new VibroSight OPC Classic Servers 

Users who have upgraded from an earlier version of VibroSight to a later version (for example, from 
VibroSight 2.x.x or 3.0.0 to VibroSight 3.1.0) can experience problems when creating new VibroSight OPC Classic 
Servers. 
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Such problems are typically characterised by the OPC Server Create command in VibroSight System Manager 
displaying an error message such as 
“The type initializer for ‘ch.VibroMeter.Xms.OpcServer.Utils.OpcServerUtils’ threw an exception”. 

This typically occurs because an earlier version of the OpcServer.config file required by VibroSight OPC Classic 
Servers is being used by the later installation of VibroSight, which can happen in one of two ways: 

• When a version of VibroSight 3.x.x or later is installed on a computer that was running a version of 
VibroSight 2.x.x or earlier, the VibroSight installer automatically checks existing VibroSight folders (such as 
C:\ProgramData\Meggitt\VibroSight 2) in order to copy relevant system and/or user preference files across to 
the new VibroSight folders (such as C:\ProgramData\Meggitt\VibroSight), including an earlier 
OpcServer.config file. 

• When VibroSight 3.1.0 is installed on a computer that was running VibroSight 3.0.0, the creation of a 
VibroSight OPC Classic installer using VibroSight 3.0.0 automatically created an earlier OpcServer.config file. 

As shown below, the first few lines of a typical OpcServer.config file contains version specific information that is 
incompatible with later versions of VibroSight: 

<?xml version="1.0" encoding="utf-8"?> 

<configuration> 

  <configSections> 

    <section name="opcServersConfiguration" type="ch.VibroMeter.Xms.OpcServer.Utils.OpcServersSystemConfiguration, 
XmsOpcServerUtils, Version=2.0.0.0, Culture=neutral, PublicKeyToken=2db2a2387bac0a0a" /> 

  </configSections> 

… 

</configuration> 

 

So for users who have upgraded from an earlier version of VibroSight to a later version, if problems are 
experienced when creating new VibroSight OPC Classic Servers, the workaround is to: 

 

1. Use an XML-compatible text editor program to edit the OpcServer.config file and remove the version specific 
information. That is, change the line containing the section name 
from: 

<section name="opcServersConfiguration" type="ch.VibroMeter.Xms.OpcServer.Utils.OpcServersSystemConfiguration, 
XmsOpcServerUtils, Version=2.0.0.0, Culture=neutral, PublicKeyToken=2db2a2387bac0a0a" /> 

to: 

<section name="opcServersConfiguration" type="ch.VibroMeter.Xms.OpcServer.Utils.OpcServersSystemConfiguration, 
XmsOpcServerUtils, Culture=neutral, PublicKeyToken=2db2a2387bac0a0a" /> 

 

2. Restart the computer. 
    Note: The computer must be restarted to ensure that the edited version of the OpcServer.config 
    file is used (and not some other version from cache memory). 
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3. Use the OPC Server Create command in VibroSight System as required. 

 

NOTE: The manual migration of existing VibroSight OPC Classic Servers to 
VibroSight 3.x.x or later is described in detail in the “VibroSight OPC Classic Server 

migration” section of the latest  Getting started with VibroSight installation 
guide. 

 

5.13  Potential TCP port 50000 conflict 

The VibroSight Host Service (XmsHostService.exe) requires TCP port 50000 for communication with the 
VibroSight software. So if the computer running the VibroSight software is running other software which also 
requires TCP port 50000, this results in a TCP port conflict which can prevent VibroSight (or the other software) 
from running. 

During the VibroSight software installation process, the VibroSight 3.4.x or later installer will typically detect other 
software on the computer that is using TCP port 50000 and report this. For example: “The port 50000 cannot be 
used. Please close all application using this port before manually starting the host service.” 

Accordingly, any potential TCP port 50000 conflicts should be resolved before the VibroSight software can be 
successfully run. 

NOTE: The VibroSight software’s TCP and UDP port requirements are described in detail 

in the “Software installation” section of the latest  Getting started with 
VibroSight installation guide. See section 4. After installing VibroSight. 

 

5.14  Problems using shared network drives/locations for VibroSight data management 

On computers running Windows 10 or Windows Server 2016, problems can be experienced using shared network 
drives/locations with VibroSight’s integrated data management operations such as Offline data storage and 
Database backup (configured in VibroSight Configurator) due to Windows security policies and restrictions. 

Such problems are typically characterised by the individual copy commands scheduled and run on a VibroSight 
Server (corresponding to Offline data storage and Database backup operations) failing to run correctly. More 
specifically, on the Data Management tab of a VibroSight Server, scheduled incremental copy jobs (Type: Copy) 
are typically displayed with Status: Error, while the Log Messages tab of the server display typically displays 
messages such as “Errors during the copy operation” and “Uncaught error IOException occurred in task ‘Task 
“DataRepositoryCopyDataMan…”. 

NOTE: For Windows 10 and Windows Server 2016, Microsoft improved network security 
with a change to the rules governing shared network drives/locations. 
More specifically, a shared network drive/location is now only accessible and 
visible to the user who created the shared network drive/location, even if the user is 
an Administrator. 
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Accordingly, in order to avoid such problems, a shared network drive/location on Windows 10 and 
Windows Server 2016 computers that is required to be used by VibroSight’s integrated data management 
operations should be created as a “system account” in order to ensure that the required Windows Services can 
access the shared resource (drive/location). 

This can easily be done using Microsoft’s PsExec utility. For example, by running the following command (as an 
Administrator): 

PsExec.exe -i -s cmd.exe /C "net use Z: \\server\share"  

Where the net use command is used to map the \\computer name\sharename (\\server\share) to the devicename 
(Z:). 
 

NOTE: For Windows 10 and Windows Server 2016, Microsoft improved network security 
with a change to the rules governing shared network drives/locations. 
More specifically, a shared network drive/location is now only accessible and 
visible to the user who created the shared network drive/location, even if the user is 
an Administrator. 

 

5.15  Problems installing VibroSight 3.7.x on computers without internet access 

On computers which are not connected to the internet, the VibroSight 3.7.x installer can experience problems when 
automatically installing the prerequisite Microsoft Visual C++ Redistributable Package for Visual Studio 2015, and 
report a generic message such as “Setup Failed. One or more issues caused the setup to fail”. 

As a workaround, trying to manual install the Microsoft Visual C++ Redistributable Package for Visual Studio 2015, 
the Microsoft Visual C++ installer can also experience problems, and report a similar generic “Setup Failed” 
message. 

This is a known Microsoft problem which is due to some components in Visual Studio being signed by a 
certification authority that is not installed on the computer, and the computer cannot automatically download the 
required certificate(s) because it is not connected to the internet. 

Accordingly, the Microsoft solution is to: 

1. On a computer which is connected to the internet, download the following certificate: 
http://www.microsoft.com/pki/certs/MicRooCerAut2011_2011_03_22.crt  
Then copy the certificate to the VibroSight computer (for example to C:\Temp). 

2. On the VibroSight computer, use the certmgr.exe utility to add the certificate by using the command line. 
Note: For more information, refer to the Certmgr.exe (Certificate Manager Tool) topic at MSDN. 

3. Open an admin command prompt and run the following command: 
certmgr.exe /add C:\Temp\MicRooCerAut2011_2011_03_22.cer /s /r localMachine root 

4.  Next, try installing the patch KB3135996 or KB3136000. 
 
If required, additional information is available from a Microsoft MSDN blog, here: 
https://blogs.msdn.microsoft.com/vsnetsetup/2016/03/28/a-certificate-chain-could-not-be-built-to-a-trusted-root-
authority-2 

https://docs.microsoft.com/en-us/sysinternals/downloads/psexec
https://blogs.msdn.microsoft.com/vsnetsetup/2016/03/28/a-certificate-chain-could-not-be-built-to-a-trusted-root-authority-2
https://blogs.msdn.microsoft.com/vsnetsetup/2016/03/28/a-certificate-chain-could-not-be-built-to-a-trusted-root-authority-2
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6 Compatibility 

As part of the VibroSight software installation process, the VibroSight installer will automatically check to see if the 
required Microsoft .NET Framework, Microsoft Visual C++ Redistributable Package, OPC Core Components 
Redistributable software and OPC UA Local Discovery Server are pre-installed on the computer: 

• The required Microsoft Visual C++ Redistributable Package (see section 6.1.3) must be manually installed 
before VibroSight can be installed. If it is not detected, then the VibroSight installer will exit the installation and 
VibroSight is not installed. 

• The required Microsoft .NET Framework (see section 6.1.2) is automatically installed by the VibroSight installer 
if it is not detected. 

• The required OPC Core Components Redistributable (see section 6.1.4) software is automatically installed on 
the computer by the VibroSight installer if it is not detected. 

• The required OPC UA Local Discovery Server (see section 6.1.5) software is automatically installed on the 
computer by the VibroSight installer if it is not detected. 

NOTE: Refer to the latest version of the  Getting started with VibroSight installation 

guide or the  VibroSight software data sheet for further information on 
VibroSight’s prerequisites and compatibility. 

 

 

6.1 VibroSight software 

VibroSight 7.2.0 is a minor level release and replaces VibroSight 7.1.x. 

Compatibility with existing VibroSight data repositories (databases) is achieved using a specific data migration 
process from any existing databases based on Sybase SQL Anywhere (*.vssrvdb) to data repositories based on 
the VibroSight historical data repositories (VibroSight historical data folder (*.vshdf) for operation with a VibroSight 
Server (live data) and VibroSight historical data archive (*.vshda) for operation with historical data). 

Compatibility with existing VibroSight machinery monitoring projects using VibroSight OPC Servers that were 
created using VibroSight 2.12.7 or earlier is achieved using a specific VibroSight OPC Server migration process for 
these VibroSight OPC Servers. 

Therefore, it is important to note that: 

• New machinery monitoring projects created with VibroSight 7.x.x (VibroSight 3.x.x or later) will automatically 
use VibroSight historical data repositories. 

• Existing machinery monitoring projects created with versions of VibroSight earlier than VibroSight 3.0.0 must 
be manually migrated from Sybase SQL Anywhere databases to VibroSight historical data repositories before 
they can be used with VibroSight 7.x.x (VibroSight 3.x.x or later). 

• Existing machinery monitoring projects using VibroSight OPC Servers that were created with versions of 
VibroSight earlier than VibroSight 2.12.7 must manually migrate their VibroSight OPC Servers before they can 
be used with VibroSight 7.x.x (VibroSight 3.x.x or later). 
It is very important to note that migrating a VibroSight OPC Server from VibroSight 2.12.7 or earlier to 
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VibroSight 7.x.x (VibroSight 3.x.x or later) or later requires that certain steps must be performed using the 
existing version of VibroSight (that is, VibroSight 2.12.7 or earlier) BEFORE it is removed (uninstalled). 

NOTE: The manual migration of an existing machinery monitoring project to 
VibroSight 7.x.x (VibroSight 3.x.x or later) or later is described in detail in the 
“Data migration” and “VibroSight OPC Server migration” sections of the latest  

 Getting started with VibroSight installation guide. 

 
 
6.1.1 Microsoft Windows operating systems 
VibroSight 7.x.x (VibroSight 3.x.x or later) or later is compatible with 32-bit versions and 64-bit versions of 
Microsoft ® Windows ® operating systems. 

NOTE: Starting with VibroSight 3.0.0, VibroSight software is now available as 64-bit 
software for 64-bit Windows and 32-bit software for 32-bit Windows. 
The 64-bit version of VibroSight can be installed on 64-bit Windows computers 
only. The 32-bit version of VibroSight can be installed on 32-bit Windows 
computers only. Only a single version of VibroSight can be installed and exist on a 
computer at any one time 

 
See the Appendix of these release notes for further information on VibroSight software and Windows operating 
system compatibility. 

 

 

6.1.2 Microsoft .NET Framework 
For most Windows operating systems, VibroSight 7.x.x (VibroSight 3.7.0 or later) requires that the Microsoft .NET 
Framework 4.7.2 or later is installed. 

NOTE: VibroSight 7.x.x requires Microsoft .NET Framework 4.7.2. 

 
If the required Microsoft .NET Framework is not pre-installed, then the VibroSight installer will detect this and 
automatically install it as part of the VibroSight software installation process. 

See the Appendix of these release notes for further information on VibroSight software and Microsoft .NET 
Framework requirements. 
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6.1.3 Microsoft Visual C++ Redistributable Package 
VibroSight 7.x.x (VibroSight 3.x.x or later) requires that the Microsoft Visual C++ Redistributable Package for Visual 
Studio 2015 is installed, in order to install and register the Visual C++ libraries used by VibroSight. 

NOTE: The 64-bit version of the Microsoft Visual C++ Redistributable Package (“Microsoft 
Visual C++ 2015 Redistributable (x64)”) must be installed on 64-bit Windows 
computers. 
The 32-bit version of the Microsoft Visual C++ Redistributable Package (“Microsoft 
Visual C++ 2015 Redistributable (x86)”) must be installed on 32-bit Windows 
computers. 

If the required Microsoft Visual C++ Redistributable Package is not pre-installed, then the VibroSight installer will 
detect this and exit the installation. 

 

 

6.1.4 OPC Core Components Redistributable 

VibroSight 7.x.x (VibroSight 3.x.x or later) requires that the OPC Core Components Redistributable is installed, in 
order to configure and run VibroSight OPC Clients and VibroSight OPC Servers correctly: the redistributable must 
be installed on OPC client computers in order to allow connections to remote OPC servers and it must be installed 
on OPC server computers in order to allow OPC clients to browse for running OPC servers. 

NOTE: The 64-bit version of the OPC Core Components Redistributable (“OPC Core 
Components Redistributable (x64) 106.0”) must be installed on 64-bit Windows 
computers. 

The 32-bit version of the OPC Core Components Redistributable (“OPC Core 
Components Redistributable (x86) 106.0”) must be installed on 32-bit Windows 
computers. 

 

If the required OPC Core Components Redistributable is not pre-installed, then the VibroSight installer will detect 
this and automatically install it as part of the VibroSight software installation. 

 

 

6.1.5 OPC UA Local Discovery Server  

VibroSight 7.x.x or later requires that the OPC UA Local Discovery Server is installed, in order to expose OPC UA 
servers for discovery and enable communications with OPC UA clients. 

If the required OPC UA Local Discovery Server is not pre-installed, then the VibroSight installer will detect this and 
automatically install it as part of the VibroSight software installation. 
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6.1.6 Sybase SQL Anywhere 11 software 

VibroSight 7.x.x (VibroSight 3.x.x or later) does not include any Sybase SQL database software. 

Starting with VibroSight 3.0.0, the VibroSight historical data repositories (VibroSight historical data folder (*.vshdf) 
for operation with a VibroSight Server (live data) and VibroSight historical data archive (*.vshda) for operation with 
historical data) are exclusively used for the required data repositories. 

A VibroSight database based on Sybase SQL Anywhere (*.vssrvdb) can no longer be used as a data repository. 
Accordingly, the Sybase SQL Anywhere 11 database software is no longer included and distributed as part of the 
VibroSight software. 

NOTE: VibroSight 3.x.x or later exclusively uses data repositories based on the VibroSight 
historical data system. 

VibroSight 2.12.7 used data repositories based on Sybase SQL Anywhere 
databases and introduced initial support for working with data repositories based 
on the VibroSight historical data repositories for data analysis. 

VibroSight 2.12.6 or earlier exclusively used data repositories based on Sybase 
SQL Anywhere databases. 

 

NOTE: The manual migration of an existing machinery monitoring project to 
VibroSight 7.x.x (VibroSight 3.x.x or later) is described in detail in the 

“Data migration” section of the latest  Getting started with VibroSight 
installation guide. 

 

 

6.1.7 Dell Backup and Recovery software 

Some Dell™ computers running versions of Dell Backup and Recovery software can experience problems running 
the VibroSight software, characterised by the VibroSight software not running or running incorrectly. This is 
because the Dell Backup and Recovery software can use a version of SQLite and associated libraries (DLLs) that 
prevent the VibroSight Host Service from running correctly. 

For example, VibroSight clients can stop running (crash), VibroSight clients can be unable to connect to data 
sources and/or VibroSight System manager may not display all of the commands expected to be available in the 
Actions window. 

If this behaviour is seen, the recommended workaround is to uninstall the Dell Backup and Recovery software. 

NOTE: It is recommended to install and use VibroSight 3.x.x or earlier on a computer that 
does not have Dell Backup and Recovery software installed. 
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6.1.8 MatrikonOPC software 

Both MatrikonOPC™ software and the VibroSight software can be installed and run on the same computer. 

However, if the MatrikonOPC software is installed after the VibroSight software, this can result in problems related 
to credentials (access rights). These problems are typically characterised by an unhandled exception in VibroSight 
Configurator when trying to configure an OPC device in the Hardware view or an unhandled exception in a 
VibroSight Server when trying to handle/process OPC data. 

MatrikonOPC software and the VibroSight software must be installed on the same computer in the following order: 

1. Install the MatrikonOPC software. 

2. Install the Microsoft Visual C++ Redistributable Package for Visual Studio 2010 (version 40219). 
Note: This redistributable package is required by the MatrikonOPC software. 

3. Install the Microsoft Visual C++ Redistributable Package for Visual Studio 2015 (version 23026 or later). 
Note: This redistributable package is required by the VibroSight software. 

4. Install VibroSight 3.x.x or later. 
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6.2 VM600Mk2/VM600 modules/cards 

6.2.1 Module/card firmware 

There are some firmware upgrades for VM600Mk2/VM600 modules/cards corresponding to VibroSight 7.2.0. 

 

The latest firmware for the VM600Mk2 MPC4Mk2 module is now: 

• Machinery protection: 640-025-007-001.Mpc4g2Fw (updated) 

• Condition monitoring: 640-033-003-000.VxeFw (updated) 

• Recovery: 640-031-005-001.Mpc4g2Fw (updated) 

• Proof test: 640-032-003-000.VxeFw (updated). 

See 2.14 MPC4Mk2 + IOC4Mk2 module – hardware and 2.15 MPC4Mk2 + IOC4Mk2 module – firmware. 

 

The latest firmware for the new VM600Mk2 CPUMMk2 module is now: 

• Base system: base-system-640-034-003-001.tgz (updated). 

See 2.16 CPUMMk2 + IOCNMk2 module. 

 

The latest firmware for the VM600 CPUR2 card remains: 

• Applications: applications-640-015-001-006.tgz 

• Base System : base-system-640-014-001-006.tgz. 

 

The latest firmware for the VM600 CPUR card remains: 

• Applications: applications-640-012-001-005.tgz 

• Base System: base-system-640-011-001-005.tgz. 

 

NOTE: In order to help distinguish between VM600Mk2 CPUx modules and VM600 CPUx 
cards, VibroSight 6.0.0 and later uses the following terminology: 
• CPUMMk2 to refer to the VM600Mk2 CPUx module with mathematical processing of 
fieldbus data and support for Modbus TCP and PROFIBUS DP (PNR 600-050). 
• CPUR2 to refer to the latest version of the VM600 CPUx card with support for 
PROFIBUS (PNR 600-026-000-vvv). 
• CPUR to refer to the earlier version of the VM600 CPUx card with support for 
Modbus RTU/TCP and card pair redundancy (PNR 600-007-000-vvv). 
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The latest firmware for the VM600Mk2/VM600 XMC16, XMV16 and XMVS16 cards remains: 

• Applications: applications-640-010-001-016.tgz 

• Base System: base-system-640-003-001-016.tgz. 

 

Therefore, for current versions of VibroSight and VM600Mk2/VM600 systems, firmware upgrades are required. 

 

 

6.3 VibroSmart devices 

6.3.1 Module firmware 

There are no firmware upgrades for VibroSmart modules and devices corresponding to VibroSight 7.2.0. 

 

The latest firmware for the VSI010 module remains: 

• 642-002-000-014.xmsifw  

 

The latest firmware for the VSN010 device remains: 

• 642-004-000-012.redboxfw  

 

The latest firmware for the VSV30x module remains: 

• 642-001-000-020.xtranfw  

 

Therefore, for current versions of VibroSmart modules and devices, no firmware upgrades are required. 
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7 Upgrade procedure 

This section describes the procedure for upgrading a VibroSight system from a previous version. Perform the steps 
in the given sequence in order to complete a system upgrade. 

NOTE: It is strongly recommended to verify the version of firmware running in the related 
hardware (XMx16 cards and VibroSmart modules and devices) before starting a 
VibroSight system upgrade, in order to establish if any firmware updates are also 
required. 
See 7.2.3 Updating the firmware using VibroSight System Manager. 

 

NOTE: It is strongly recommended to ensure that a copy of the configuration for a 
VibroSmart is available before updating the firmware of any of the VibroSmart 
modules used in the distributed monitoring system. See 7.2.3 Updating the 
firmware using VibroSight System Manager. 

 

 

7.1 VibroSight software user settings 

The VibroSight Software generates and uses some files on the storage device of the computer running VibroSight 
to keep track of user-configurable settings, so that these settings are remembered and applied for the VibroSight 
installation. 

These settings files have an .xmssettings file name extension and on a computer running Windows 7, can be found 
here: 

C:\Users\username\AppData\Roaming\Meggitt\VibroSight, where username is the Windows account name. 

For example, the VibroSightVision.xmssettings file records the user-configurable default settings for VibroSight 
Vision, such as default settings for plots. 

NOTE: VibroSight software updates and upgrades do not replace these settings files, so: 
• For a computer on which VibroSight was previously installed, an update, upgrade 
or a re-installation of VibroSight will continue to use the previous defaults recorded 
in the .xmssettings files. 
• For a computer on which VibroSight was not previously installed, the installation 
of VibroSight will generate and use new .xmssettings files, which use the latest 
VibroSight software defaults. 

If a settings file is deleted for any reason, VibroSight will generate and use a new 
settings file, which uses the latest VibroSight software defaults. 
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7.2 Updating VibroSight-compatible hardware 

Appropriate files and tools are included in the installation package to allow VM600Mk2/VM600 modules/cards 
(XMx16) and VibroSmart devices (VSI010, VSN010 and VSV30x) to be updated to the latest firmware, in order to 
take advantage of improvements to the VibroSight software. 

Updating the firmware for VM600Mk2/VM600 modules/cards cards or VibroSmart devices is a special task that can, 
if used unintentionally or incorrectly, lead to malfunctioning of the device and affect proper function of data 
acquisition. 

During the firmware update of a device, the card or module being updated cannot provide its normal machinery 
monitoring functions because its outputs (alarms and relays) can go to undetermined states, irrespective of how 
they have been configured. 

For VibroSmart modules, the machinery being monitored is not protected for the duration of a firmware update and 
the restart (reboot) that is triggered automatically after the firmware update (which can take up to 5 minutes). 

NOTE: It is highly recommended that firmware updates are only performed in accordance 
with the operating procedures for the machinery being monitored and that 
appropriate precautions are taken at the control system level (such as DCS 
or PLC). 

For example, alarms and relay outputs should be ignored (bypassed or inhibited) in 
order to avoid false trips of the machinery being monitored. 

 

7.2.1 VM600Mk2/VM600 module/card firmware 

The latest VM600Mk2/VM600 module/card firmware files are copied to a directory on your computer as part of the 
VibroSight software installation process. 

NOTE: For example, the default firmware directory for VM600Mk2/VM600 modules/cards is: 
C:\Program Files\Meggitt\VibroSight\Firmware\VM600 

 

The firmware files for a VM600Mk2/VM600 module/card can be found in the appropriate subfolder and identified by 
their .tgz file name extension. For example, the XMV16 subfolder contains the applications and base system 
firmware for use by XMV16 cards. Any additional firmware updates received from Meggitt SA should also be stored 
in these directories. 

Table 1 shows the compatibility between VibroSight software and VM600Mk2 MPC4Mk2 module hardware (that is, 
MPC4Mk2 firmware) for later versions of the MPC4Mk2 (PNRs 600-041-001-002 and 600-041-000-002). 

Table 2 shows the compatibility between VibroSight software and VM600Mk2 MPC4Mk2 module hardware (that is, 
MPC4Mk2 firmware) for the original version of the MPC4Mk2 (PNR 600-041-000-001) – no longer supported. 
See 2.14 MPC4Mk2 + IOC4Mk2 module – hardware. 

Table 3 shows the compatibility between VibroSight software and VM600Mk2 CPUMMk2 module hardware (that is, 
CPUMMk2 firmware). 

Table 4 shows the compatibility between VibroSight software and VM600 CPUR2 card hardware (that is, 
CPUR2 firmware). 
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Table 5 shows the compatibility between VibroSight software and VM600 CPUR card hardware (that is, 
CPUR firmware). 

Table 6 shows the compatibility between VibroSight software and VM600 XMx16 card hardware (that is, 
XMC16, XMV16 and XMVS16 firmware). 

NOTE: It is strongly recommended to use the most recent version of the VM600 CPUR 
firmware and VM600 XMx16 firmware that is compatible with the version of 
VibroSight software being used. 
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Table 1: VibroSight software and VM600Mk2 MPC4Mk2 firmware compatibility 

for later versions of the MPC4Mk2 (PNRs 600-041-001-002 and 600-041-000-002) 

 VM600Mk2 MPC4Mk2 firmware 

VibroSight software 
version 

Part number (PNR) 

Machinery protection firmware (640-025-vvv-ppp.Mpc4g2Fw) 

640-025- 

004-000 

640-025- 

004-003 

640-025- 

005-000 

640-025- 

006-000 

640-025- 

007-001 

Condition monitoring firmware (640-033-vvv-ppp.VxeFw) 

--- --- 640-033- 

001-000 

640-033- 

002-000 

640-033- 

003-000 

Recovery firmware (640-031-vvv-ppp.Mpc4g2Fw) 

640-031- 

003-004 

640-031- 

003-006 

640-031- 

005-001 

Proof test firmware (640-032-vvv-ppp.VxeFw) 

640-032- 

001-000 

640-032- 

001-001 

640-032- 

003-000 

6.0.0 
609-004-000-050 

 
    

6.1.0 
609-004-000-051 

 See note 1   
  

7.0.0 
609-010-000-001 

  See note 2a  See note 2b 
  

7.1.0 
609-010-000-001 

    See note 3 
 

7.2.0 
609-010-000-001 

     See note 4 

 

Notes for Table 1 (see the next page) 
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Notes for Table 1 
1. This version of VM600Mk2 MPC4Mk2 firmware improves frequency domain measurements (the phase component can be used as the input 
signal for an analog output), differential expansion (dual taper) processing (the ramp angles for the taper on the shaft are configured separately), 
auxiliary input channels configured as tacho inputs (appropriate data quality indicators and warning messages, with automatic recovery), and 
the maximum tacho speed / frequency has been increased. It also includes a number of bug fixes. (Refer to the VibroSight 6.1 release notes for 
further information.) A firmware upgrade is required in order to run VibroSight 6.1.0 or later. 
 
2a. For information on these versions of VM600Mk2 MPC4Mk2 firmware, refer to the VibroSight 7.0 release notes. 
A firmware upgrade is required in order to run VibroSight 7.0.0 or later. 
 

2b. For information on these versions of VM600Mk2 MPC4Mk2 firmware, refer to the VibroSight 7.0 release notes. 
A firmware upgrade is required in order to run VibroSight 7.0.0 or later. 
 
3. For information on these versions of VM600Mk2 MPC4Mk2 firmware, refer to the VibroSight 7.1 release notes. 
A firmware upgrade is required in order to run VibroSight 7.1.0 or later. 
 
4. For information on these versions of VM600Mk2 MPC4Mk2 firmware, see 2.15 MPC4Mk2 + IOC4Mk2 module – firmware. 
A firmware upgrade is required in order to run VibroSight 7.2.0 or later. 
See also 2.14 MPC4Mk2 + IOC4Mk2 module – hardware.  
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Table 2: VibroSight software and VM600Mk2 MPC4Mk2 firmware compatibility 

for the original version of MPC4Mk2 (PNR 600-041-000-001) – no longer supported 

 VM600Mk2 MPC4Mk2 firmware 

VibroSight software 
version 

Part number (PNR) 

Machinery protection firmware (640-025-vvv-ppp.Mpc4g2Fw) 

640-025- 

003-002 

640-025- 

004-000 

640-025- 

004-003 

640-025- 

005-000 

640-025- 

006-000 

Condition monitoring firmware (640-033-vvv-ppp.VxeFw) 

--- --- --- 640-033- 

001-000 

640-033- 

002-000 

Recovery firmware (640-031-vvv-ppp.Mpc4g2Fw) 

640-031- 

003-002 

640-031- 

003-004 

640-031- 

003-006 

Proof test firmware (640-032-vvv-ppp.VxeFw) 

640-032- 

001-000 

640-032- 

001-001 

6.0.0 
609-004-000-050 

 See note 1  
   

6.1.0 
609-004-000-051 

  See note 2   
 

7.0.0 
609-010-000-001 

   See note 3a  See note 3b 
 

7.1.0 
609-010-000-001 

     See note 4 

 

Notes for Table 2 (see the next page) 
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Notes for Table 2 
1. This version of VM600Mk2 MPC4Mk2 (previously referred to as VM600 MPC4G2) firmware is the official launch release of firmware supporting 
VibroSight Protect and VM600Mk2 systems. A firmware upgrade is required in order to run VibroSight 6.0.0 or later – that is, to use VM600Mk2 
systems in “live” machinery protection system (MPS) applications. Contact Meggitt SA for further information. 
 

2. This version of VM600Mk2 MPC4Mk2 firmware improves frequency domain measurements (the phase component can be used as the input 
signal for an analog output), differential expansion (dual taper) processing (the ramp angles for the taper on the shaft are configured separately), 
auxiliary input channels configured as tacho inputs (appropriate data quality indicators and warning messages, with automatic recovery), and 
the maximum tacho speed / frequency has been increased. It also includes a number of bug fixes. (Refer to the VibroSight 6.1 release notes for 
further information.) A firmware upgrade is required in order to run VibroSight 6.1.0 or later. 
 
3a. For information on these versions of VM600Mk2 MPC4Mk2 firmware, refer to the VibroSight 7.0 release notes. 
A firmware upgrade is required in order to run VibroSight 7.0.0 or later. 
 

3b. For information on these versions of VM600Mk2 MPC4Mk2 firmware, refer to the VibroSight 7.0 release notes. 
A firmware upgrade is required in order to run VibroSight 7.0.0 or later. 
 

4. For information on these versions of VM600Mk2 MPC4Mk2 firmware, refer to the VibroSight 7.1 release notes. 
A firmware upgrade is required in order to run VibroSight 7.1.0. 
See also 2.14 MPC4Mk2 + IOC4Mk2 module – hardware. 
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Table 3: VibroSight software and VM600Mk2 CPUMMk2 firmware compatibility 

 VM600Mk2 CPUMMk2 firmware  See note 1 

VibroSight software version 

Part number (PNR) 

Base-system / Applications firmware (*.tgz) 

640-034-001-000 640-034-001-001 640-034-002-000 640-034-003-000 

6.1.0 
609-004-000-051 

 See note 2   
 

7.0.0 
609-010-000-001 

  See note 3  
 

7.1.0 
609-010-000-001 

   See note 4  

7.2.0 
609-010-000-001 

    See note 5 

 

Notes for Table 3 
1. VM600 CPUR2 firmware is packaged and distributed as a .tgz file (a compressed archive file format) with PNRs such as 640-034-001-xxx for 
the base system firmware. In these PNRs, the xxx-xxx-001-xxx denotes the firmware is packaged in the tgz file format. 

After the .tgz file is unpacked by VibroSight System Manager and the firmware is uploaded to a VM600 CPUMMk2 module, the dialog box 
displayed by the VibroSight System Manager’s Change Firmware command shows the current version of firmware using PNRs such as 640-
034-000-xxx for the base system firmware, which correspond to the actual unpacked firmware that is running on the module. 
 

2. This version of VM600Mk2 CPUMMk2 firmware is the official launch release of firmware supporting VM600Mk2 systems. (Refer to the 
VibroSight 6.1 release notes for further information.) A firmware upgrade is required in order to run VibroSight 6.1.0 or later. 
 

3. For information on this version of VM600Mk2 CPUMMk2 firmware, refer to the VibroSight 7.0 release notes. 
A firmware upgrade is required in order to run VibroSight 7.0.0 or later. 
 

4. For information on this version of VM600Mk2 CPUMMk2 firmware, refer to the VibroSight 7.1 release notes. 
A firmware upgrade is required in order to run VibroSight 7.1.0 or later. 
 

5. For information on this version of VM600Mk2 CPUMMk2 firmware, see 2.16 CPUMMk2 + IOCNMk2 module. 
A firmware upgrade is required in order to run VibroSight 7.2.0 or later. 
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Table 4: VibroSight software and VM600 CPUR2 firmware compatibility 

 VM600 CPUR2 firmware  See note 1 

VibroSight software 
version 

Part number (PNR) 

Base-system firmware (*.tgz) 

640-014- 

001-001 

640-014- 

001-002 

640-014- 

001-003 

640-014-001-

005 

640-014-001-

006 

Applications firmware (*.tgz) 

640-015- 

001-001 

640-015- 

001-002 

640-015- 

001-003 

640-015- 

001-005 

640-015- 

001-006 

3.6.0 
609-004-000-043 

 See note 2  See note 3   
 

3.7.0 
609-004-000-044 

    
 

3.8.0 
609-004-000-045 

    
 

4.0.0 
609-004-000-046 

 See note 2  See note 3   
 

4.1.0 
609-004-000-047 

   See note 4  
 

5.0.0 
609-004-000-048 

    
 

5.1.0 
609-004-000-049 

    
 

6.0.0 
609-004-000-050 

    
 

6.1.0 
609-004-000-051 

    
 

7.0.0 
609-010-000-001 

    See note 5 
 

7.1.0 
609-010-000-001 

     See note 6 

7.2.0 
609-010-000-001 

     

 

Notes for Table 4 (see the next page)  



 

Document reference VIBROSIGHT-RN/E (660-010-013-235A) 
Version 35 – 19.01.2023 

RELEASE NOTES 
VibroSight® 7.2.0 

61 / 78 
 

Notes for Table 4 
1. VM600 CPUR2 firmware is packaged and distributed as a .tgz file (a compressed archive file format) with PNRs such as 640-014-001-xxx for 
the Base System and 640-015-001-xxx for the (Applications) Firmware. In these PNRs, the xxx-xxx-001-xxx denotes the firmware is packaged 
in the tgz file format. 

After the .tgz file is unpacked by VibroSight System Manager and the firmware is uploaded to a VM600 CPUR2 card, the dialog box displayed 
by the VibroSight System Manager’s Change Firmware command shows the current version of firmware using PNRs such as 640-014-000-xxx 
for the Base System and 640-015-000-xxx for the Firmware, which correspond to the actual unpacked firmware that is running on the card. 
 

2. This is the first official release of VM600 CPUR2 firmware and includes features such as the management of XMx16 card configurations for 
applications such as control systems and the implementation of the PROFIBUS protocol for the fieldbus interfaces. A firmware upgrade is 
required in order to run VibroSight 2.12.7 or later. 
 

3. This version of VM600 CPUR2 firmware includes improvements such as changing the PROFIBUS polling rate for the Modbus server to 
100 ms (was 200 ms) and a bug fix for a known VM600 CPUx time counter wraparound (overflow) issue. A firmware upgrade is strongly 
recommended in order to run VibroSight 3.4.0 or later. 
 

4. This version of VM600 CPUR2 firmware includes improvements such as overall performance, responsiveness and stability, and support for 
CPUR2/IOCR2 card pair relays, and the ability to download the GSD file directly from the card. A firmware upgrade is strongly recommended 
but is not required in order to run VibroSight 4.1.0 or later. 
Note: VibroSight 4.1.0 or later must be used in order to download the VM600 CPUR2 GSD file directly from the CPUR2 card. 
 

5. For information on this version of VM600Mk2 CPUR2 firmware, refer to the VibroSight 7.0 release notes. 
A firmware upgrade is required in order to run VibroSight 7.0.0 or later. 
 

6. For information on this version of VM600Mk2 CPUR2 firmware, refer to the VibroSight 7.0 release notes. 
A firmware upgrade is required in order to run VibroSight 7.1.0 or later. 
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Table 5: VibroSight software and VM600 CPUR firmware compatibility 

 VM600 CPUR firmware  See note 1 

VibroSight software version 

Part number (PNR) 

Base-system firmware (*.tgz) 

640-011-001-004 640-011-001-005 

Applications firmware (*.tgz) 

640-012-001-004 640-012-001-005 

4.0.0 
609-004-000-046 

 See note 2  

4.1.0 
609-004-000-047 

  See note 3 

5.0.0 
609-004-000-048 

  

5.1.0 
609-004-000-049 

  

6.0.0 
609-004-000-050 

  

6.1.0 
609-004-000-051 

  

7.0.0 
609-010-000-001 

  

7.1.0 
609-010-000-001 

  

7.2.0 
609-010-000-001 

  

 

Notes for Table 5 
1. VM600 CPUR firmware is packaged and distributed as a .tgz file (a compressed archive file format) with PNRs such as 640-011-001-xxx for 
the Base System and 640-012-001-xxx for the (Applications) Firmware. In these PNRs, the xxx-xxx-001-xxx denotes the firmware is packaged 
in the tgz file format. 

After the .tgz file is unpacked by VibroSight System Manager and the firmware is uploaded to a VM600 CPUR card, the dialog box displayed by 
the VibroSight System Manager’s Change Firmware command shows the current version of firmware using PNRs such as 640-011-000-xxx for 
the Base System and 640-012-000-xxx for the Firmware, which correspond to the actual unpacked firmware that is running on the card. 
 

2. This is the latest official release of VM600 CPUR firmware (that is, the earlier version of the CPUx card with support for card pair redundancy 
(PNR 600-007-000-vvv)), which was discontinued in VibroSight 2.12.0 and reintroduced in VibroSight 4.0.x). 
 
3. This version of VM600 CPUR firmware includes a bug fix for a known VM600 CPUx time counter wraparound (overflow) issue and the 
addition of relay outputs to the diagnostics logs. A firmware upgrade is strongly recommended but is not required in order to run VibroSight 4.1.0 
or later.  
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Table 6: VibroSight software and VM600 XMx16 firmware compatibility 

 VM600 XMx16 firmware  See note 1 

VibroSight software version 

Part number (PNR) 

Base-system firmware (*.tgz) 

640-003-001-016 

Applications firmware (*.tgz) 

640-010-001-016 

3.5.0 
609-004-000-042 

 See note 2 

3.6.0 
609-004-000-043 

 

3.7.0 
609-004-000-044 

 

3.8.0 
609-004-000-045 

 

4.0.0 
609-004-000-046 

 

4.1.0 
609-004-000-047 

 

5.0.0 
609-004-000-048 

 

5.1.0 
609-004-000-049 

 

6.0.0 
609-004-000-050 

 

6.1.0 
609-004-000-051 

 

7.0.0 
609-010-000-001 

 

7.1.0 
609-010-000-001 

 

7.2.0 
609-010-000-001 

 

 

Notes for Table 6 (see the next page)  
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Notes for Table 6 
1. VM600 XMx16 firmware is packaged and distributed as a .tgz file (a compressed archive file format) with PNRs such as 640-003-001-xxx for 
the Base System and 640-010-001-xxx for the (Applications) Firmware. In these PNRs, the xxx-xxx-001-xxx denotes the firmware is packaged 
in the tgz file format. 

After the .tgz file is unpacked by VibroSight System Manager and the firmware is uploaded to a VM600 XMx16 card, the dialog box displayed by 
the VibroSight System Manager’s Change Firmware command shows the current version of firmware using PNRs such as 640-010-000-xxx for 
the Firmware and 640-003-000-xxx for the Base System, which correspond to the actual unpacked firmware that is running on the card. 
 

2. This version of VM600 XMx16 firmware includes relaxed constraints for dynamic data retention time, that is, optimised memory to reduce the 
possibility of missing data in data intensive VibroSight applications running on less powerful computers. A firmware upgrade is required in order 
to run VibroSight 3.3.0 or later. 
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7.2.2 VibroSmart device firmware 

The latest VibroSmart device firmware files are copied to a directory on your computer as part of the VibroSight 
software installation process. 

NOTE: The default firmware directory for VibroSmart devices is: 
C:\Program Files\Meggitt\VibroSight\Firmware\VibroSmart 

 

The firmware files for a VibroSmart device can be found in the appropriate subfolder and identified by their .*fw 
file name extension. For example, the VSV30x subfolder contains the firmware for use by VSV30x modules. Any 
additional firmware updates received from Meggitt SA should also be stored in these directories. 

Table 7 shows the compatibility between VibroSight software and the VibroSmart VSI010 firmware. 

Table 8 shows the compatibility between VibroSight software and the VibroSmart VSN010 firmware. 

Table 9 shows the compatibility between VibroSight software and the VibroSmart VSV30x firmware. 

 

NOTE: It is strongly recommended to use the most recent version of the VibroSmart 
firmware that is compatible with the version of VibroSight software being used. 
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Table 7: VibroSight software and VibroSmart VSI010 firmware compatibility 

 VSI010 firmware (*.xmsifw)  See note 1 

VibroSight 
software version 

Part number 
(PNR) 

642-002-000-010 642-002-000-011 642-002-000-012 642-002-000-013 642-002-000-014 

5.0.0 
609-004-000-048 

See notes 

2 and 3 

See notes 

2 and 4 

See notes 

2 and 5 
 

 

5.1.0 
609-004-000-049 

    
 

6.0.0 
609-004-000-050 

   
  

6.1.0 
609-004-000-051 

   
See notes 

2 and 6 

 

7.0.0 
609-010-000-001 

    
 

7.1.0 
609-010-000-001 

    
See notes 

2 and 7 

7.2.0 
609-010-000-001 

     

 

Notes for Table 7 (see the next page)  
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Notes for Table 7 
1. VibroSmart VSI010 firmware is distributed as a single .xmsifw file (a proprietary file format) with a PNR such as 642-xxx-000-xxx. In these 
PNRs, the xxx-xxx-000-xxx denotes that the firmware is not packaged (compressed or archived). VibroSight System Manager always uses and 
displays information about VibroSmart device firmware using PNRs such as 642-xxx-000-xxx, which correspond to the actual firmware that is 
running on the device. 
 

2. Updating to this version of VibroSmart VSI010 firmware requires a specific process: 

Notes: For a VibroSmart consisting of different types of device, the devices should be updated in the following order: first VSN010 real-time 
Ethernet switches, then VSV30x vibration monitoring modules and finally VSI010 communications interface modules. In addition, VibroSight 
System Manager should be exited (closed) and restarted after updating the firmware for each type of device, before continuing. And after 
updating the firmware, the configuration on the VibroSmart devices should be re-applied (re-activated) and the VibroSmart devices should be 
restarted. 

Procedure: 

(1) Ensure that a copy of the configuration for the VibroSmart is available before updating any device firmware. For example, using the currently 
installed version of VibroSight (that is, before any updates to the VibroSight software corresponding to updates to VibroSmart devices), 
VibroSight Configurator can be used to obtain a copy of the configuration as follows: 
• For a VibroSmart using a VibroSight Server, the File > Open > Server / Database command can be used to read the configuration from the 
VibroSight Server. 
• For a VibroSmart not using a VibroSight Server (that is, a “stand-alone” VibroSmart), the File > Open > Device command can be used to read 
the configuration directly from the VibroSmart modules. 
Then the File > Save As > File command can be used to store a copy of the configuration for the VibroSmart. 

(2) Start VibroSight System Manager, select the device or devices of the same type to be updated (for example, VSI010 modules) and run the 
Change Firmware command. 
When updating multiple VibroSmart devices of the same type to use the same firmware, CTRL+click or SHIFT+click can be used to select 
multiple devices in the Devices tree structure of the System Explorer window. This way, when the Change Firmware command is run, all of 
devices that were selected will be updated at the same time. Otherwise, each device must be selected and updated individually. 

(3) When the VibroSmart Module(s) Firmware Upgrade window displays a “Firmware upgrade terminated. The firmware has been upgraded 
successfully …” message, click the Finish button to continue. 
If after 10 minutes, the VibroSmart Module(s) Firmware Upgrade window does not display a successful message, click the Cancel button to 
close the window and continue. 
Then exit (close) VibroSight System Manager. 

(4) Restart VibroSight System Manager and verify that the correct version of firmware is reported for each device that was updated. (When a 
device is selected in the System Explorer window, this information is available in the main window (centre) under Module PNR. It is also 
available in the VibroSmart Module(s) Firmware Upgrade window when a device is selected and the Change Firmware command is run). 
If a device does not report the correct version of firmware, rerun the Change Firmware command for this device. 
Then exit (close) VibroSight System Manager. 

(5) Repeat steps (2), (3) and (4) for each type of device to be updated (for example, VSN010 and VSV30x modules). 

(6) Start VibroSight Configurator, open the configuration for the VibroSmart (see step (1)), then apply (activate) the configuration. (If required, 
VibroSight Configurator will automatically update the configuration to the latest version and inform the user.) 
Then exit (close) VibroSight Configurator. 

(7) Turn the power supply to the VibroSmart off and wait for a few seconds. Then turn the power supply back on and verify that the system 
operates as expected. 

During this firmware update process, the behaviour of the LEDs on the front panel of the VibroSmart devices can be inconsistent and should be 
ignored. Normal LED behaviour resumes after the firmware update is complete (after step (7)). 
 

3. This version of VibroSmart VSI010 firmware has no limit on the number of constants per VSI010 module. 
A firmware upgrade is recommended but is not required in order to run VibroSight 3.8.0 or later. 

4. This version of VibroSmart VSI010 firmware adds support for Modbus function code 03. 
A firmware upgrade is required in order to run VibroSight 5.0.0 or later. 

5. This version of VibroSmart VSI010 firmware adds support for module lock and the GOOSE communications protocol (IEC 61850). 
A firmware upgrade is required in order to run VibroSight 5.0.0 or later. 

6. For information on this version of VibroSmart VSI010 firmware, refer to the VibroSight 6.1 release notes. 
A firmware upgrade is required in order to run VibroSight 6.1.0 or later. 

7. For information on this version of VibroSmart VSI010 firmware, refer to the VibroSight 7.1 release notes.  
A firmware upgrade is required in order to run VibroSight 7.1.0 or later.  
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Table 8: VibroSight software and VibroSmart VSN010 firmware compatibility 

 VSN010 firmware (*.redboxfw)  See note 1 

VibroSight software version 
Part number (PNR) 

642-004-000-011 642-004-000-012 

5.0.0 
609-004-000-048 

 See note 2 
 

5.1.0 
609-004-000-049 

 
 

6.0.0 
609-004-000-050 

 
 

6.1.0 
609-004-000-051 

 
 

7.0.0 
609-010-000-001 

 
 

7.1.0 
609-010-000-001 

 
See notes 

2 and 3 

7.2.0 
609-010-000-001 

  

 

Notes for Table 8 (see the next page)  
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Notes for Table 8 
1. VibroSmart VSN010 firmware is distributed as a single .redboxfw file (a proprietary file format) with a PNR such as 642-xxx-000-xxx. In these 
PNRs, the xxx-xxx-000-xxx denotes that the firmware is not packaged (compressed or archived). VibroSight System Manager always uses and 
displays information about VibroSmart device firmware using PNRs such as 642-xxx-000-xxx, which correspond to the actual firmware that is 
running on the device. 
 

2. Updating to this version of VibroSmart VSN010 firmware requires a specific process: 

Notes: For a VibroSmart consisting of different types of device, the devices should be updated in the following order: first VSN010 real-time 
Ethernet switches, then VSV30x vibration monitoring modules and finally VSI010 communications interface modules. In addition, VibroSight 
System Manager should be exited (closed) and restarted after updating the firmware for each type of device, before continuing. And after 
updating the firmware, the configuration on the VibroSmart devices should be re-applied (re-activated) and the VibroSmart devices should be 
restarted. 

Procedure: 

(1) Ensure that a copy of the configuration for the VibroSmart is available before updating any device firmware. For example, using the currently 
installed version of VibroSight (that is, before any updates to the VibroSight software corresponding to updates to VibroSmart devices), 
VibroSight Configurator can be used to obtain a copy of the configuration as follows: 
• For a VibroSmart using a VibroSight Server, the File > Open > Server / Database command can be used to read the configuration from the 
VibroSight Server. 
• For a VibroSmart not using a VibroSight Server (that is, a “stand-alone” VibroSmart), the File > Open > Device command can be used to read 
the configuration directly from the VibroSmart modules. 
Then the File > Save As > File command can be used to store a copy of the configuration for the VibroSmart. 

 (2) Start VibroSight System Manager, select the device or devices of the same type to be updated (for example, VSN010 modules) and run the 
Change Firmware command. 
When updating multiple VibroSmart devices of the same type to use the same firmware, CTRL+click or SHIFT+click can be used to select 
multiple devices in the Devices tree structure of the System Explorer window. This way, when the Change Firmware command is run, all of 
devices that were selected will be updated at the same time. Otherwise, each device must be selected and updated individually. 

(3) When the VibroSmart Module(s) Firmware Upgrade window displays a “Firmware upgrade terminated. The firmware has been upgraded 
successfully …” message, click the Finish button to continue. 
If after 10 minutes, the VibroSmart Module(s) Firmware Upgrade window does not display a successful message, click the Cancel button to 
close the window and continue. 
Then exit (close) VibroSight System Manager. 

(4) Restart VibroSight System Manager and verify that the correct version of firmware is reported for each device that was updated. (When a 
device is selected in the System Explorer window, this information is available in the main window (centre) under Module PNR. It is also 
available in the VibroSmart Module(s) Firmware Upgrade window when a device is selected and the Change Firmware command is run). 
If a device does not report the correct version of firmware, rerun the Change Firmware command for this device. 
Then exit (close) VibroSight System Manager. 

(5) Repeat steps (2), (3) and (4) for each type of device to be updated (for example, VSI010 and VSV30x modules). 

(6) Start VibroSight Configurator, open the configuration for the VibroSmart (see step (1)), then apply (activate) the configuration. (If required, 
VibroSight Configurator will automatically update the configuration to the latest version and inform the user.) 
Then exit (close) VibroSight Configurator. 

(7) Turn the power supply to the VibroSmart off and wait for a few seconds. Then turn the power supply back on and verify that the system 
operates as expected. 

During this firmware update process, the behaviour of the LEDs on the front panel of the VibroSmart devices can be inconsistent and should be 
ignored. Normal LED behaviour resumes after the firmware update is complete (after step (7)). 
 

3. For information on this version of VibroSmart VSN010 firmware, refer to the VibroSight 7.1 release notes.  
A firmware upgrade is required in order to run VibroSight 7.1.0 or later. 
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Table 9: VibroSight software and VibroSmart VSV30x firmware compatibility 

 VSV30x firmware (*.xtranfw)  See note 1 

VibroSight 
software version 

Part number 
(PNR) 

642-001-000-017 642-001-000-018 

642-001-000- 

000DEV_ 

SVN14937_ 

2020-05-20 

642-001-000-019 642-001-000-020 

5.0.0 
609-004-000-048 

See notes 

2 and 3 

See notes 

2 and 4 

   

5.1.0 
609-004-000-049 

  
See notes 

2 and 5 
 

 

6.0.0 
609-004-000-050 

   
  

6.1.0 
609-004-000-051 

   
See notes 

2 and 6 

 

7.0.0 
609-010-000-001 

    
 

7.1.0 
609-010-000-001 

    
See notes 

2 and 7 

7.2.0 
609-010-000-001 

     

 

Notes for Table 9 (see the next page)  
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Notes for Table 9 
1. VibroSmart VSV30x firmware is distributed as a single .xtranfw file (a proprietary file format) with a PNR such as 642-xxx-000-xxx. In these 
PNRs, the xxx-xxx-000-xxx denotes that the firmware is not packaged (compressed or archived). VibroSight System Manager always uses and 
displays information about VibroSmart device firmware using PNRs such as 642-xxx-000-xxx, which correspond to the actual firmware that is 
running on the device. 
 

2. Updating to this version of VibroSmart VSV30x firmware requires a specific process: 

Notes: For a VibroSmart consisting of different types of device, the devices should be updated in the following order: first VSN010 real-time 
Ethernet switches, then VSV30x vibration monitoring modules and finally VSI010 communications interface modules. In addition, VibroSight 
System Manager should be exited (closed) and restarted after updating the firmware for each type of device, before continuing. And after 
updating the firmware, the configuration on the VibroSmart devices should be re-applied (re-activated) and the VibroSmart devices should be 
restarted. 

Procedure: 

(1) Ensure that a copy of the configuration for the VibroSmart is available before updating any device firmware. For example, using the currently 
installed version of VibroSight (that is, before any updates to the VibroSight software corresponding to updates to VibroSmart devices), 
VibroSight Configurator can be used to obtain a copy of the configuration as follows: 
• For a VibroSmart using a VibroSight Server, the File > Open > Server / Database command can be used to read the configuration from the 
VibroSight Server. 
• For a VibroSmart not using a VibroSight Server (that is, a “stand-alone” VibroSmart), the File > Open > Device command can be used to read 
the configuration directly from the VibroSmart modules. 
Then the File > Save As > File command can be used to store a copy of the configuration for the VibroSmart. 
(2) Start VibroSight System Manager, select the device or devices of the same type to be updated (for example, VSV30x modules) and run the 
Change Firmware command. 
When updating multiple VibroSmart devices of the same type to use the same firmware, CTRL+click or SHIFT+click can be used to select 
multiple devices in the Devices tree structure of the System Explorer window. This way, when the Change Firmware command is run, all of 
devices that were selected will be updated at the same time. Otherwise, each device must be selected and updated individually. 
(3) When the VibroSmart Module(s) Firmware Upgrade window displays a “Firmware upgrade terminated. The firmware has been upgraded 
successfully …” message, click the Finish button to continue. 
If after 10 minutes, the VibroSmart Module(s) Firmware Upgrade window does not display a successful message, click the Cancel button to 
close the window and continue. 
Then exit (close) VibroSight System Manager. 
(4) Restart VibroSight System Manager and verify that the correct version of firmware is reported for each device that was updated. (When a 
device is selected in the System Explorer window, this information is available in the main window (centre) under Module PNR. It is also 
available in the VibroSmart Module(s) Firmware Upgrade window when a device is selected and the Change Firmware command is run). 
If a device does not report the correct version of firmware, rerun the Change Firmware command for this device. 
Then exit (close) VibroSight System Manager. 
(5) Repeat steps (2), (3) and (4) for each type of device to be updated (for example, VSI010 and VSN010 modules). 
(6) Start VibroSight Configurator, open the configuration for the VibroSmart (see step (1)), then apply (activate) the configuration. (If required, 
VibroSight Configurator will automatically update the configuration to the latest version and inform the user.) 
Then exit (close) VibroSight Configurator. 
(7) Turn the power supply to the VibroSmart off and wait for a few seconds. Then turn the power supply back on and verify that the system 
operates as expected. 
During this firmware update process, the behaviour of the LEDs on the front panel of the VibroSmart devices can be inconsistent and should be 
ignored. Normal LED behaviour resumes after the firmware update is complete (after step (7)). 
 

3. This version of VibroSmart VSV30x firmware adds support for configurable tacho ratios, flexible input channel to processing block mapping, 
and up to two tacho processing blocks. A firmware upgrade is required in order to run VibroSight 5.0.0 or later. 

4. This version of VibroSmart VSV30x firmware adds support for module lock, PTP (precision time protocol) time synchronisation, channel 
bypass and pre-trigger data logging. A firmware upgrade is required in order to run VibroSight 5.0.0 or later. 

5. This version of VibroSmart VSV30x firmware improves support for hydro air-gap and magnetic-flux monitoring with a minor bug fix. 
A firmware upgrade is required in order to run VibroSight 5.1.0 or later. 

6. For information on this version of VibroSmart VSV30x firmware, refer to the VibroSight 6.1 release notes. 
A firmware upgrade is required in order to run VibroSight 6.1.0 or later. 

7. For information on this version of VibroSmart VSV30x firmware, refer to the VibroSight 7.1 release notes.  
A firmware upgrade is required in order to run VibroSight 7.1.0 or later. 
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7.2.3 Updating the firmware using VibroSight System Manager 

When performing VibroSight software upgrades, it is strongly recommended to systematically upgrade the firmware 
of VM600 XMx16 cards and VibroSmart devices to the latest compatible version. 

Failure to perform a necessary VibroSight-compatible VM600Mk2/VM600 module/card firmware update may lead to 
incoherent system behaviour and affect the proper functioning of data acquisition in a system. It is only in systems 
where the firmware running on the XMx16 cards and VibroSmart devices already corresponds to the latest 
available version that no firmware update is required. Therefore, it is strongly recommended to verify the version of 
firmware running on the hardware before starting a VibroSight system upgrade, in order to establish if a firmware 
update is also required. 

NOTE: Changing the firmware of the VibroSight hardware is a special administrative task 
that can – if performed unintentionally – affect the proper functioning of data 
acquisition in a system. 

It is therefore strongly recommended to change the firmware of the VibroSight 
hardware only when it is necessary. For example, when the devices must be 
updated to be compatible with a VibroSight software upgrade. 

 

For VibroSmart modules, each module can be selected and its firmware updated individually. Alternatively, multiple 
modules of the same type (for example, VSV3x0) can be updated to the same version of firmware at the same 
time. 

NOTE: It is strongly recommended to ensure that a copy of the configuration for a 
VibroSmart is available before updating the firmware of any of the VibroSmart 
modules used in the distributed monitoring system. 

For example, using the currently installed version of VibroSight (that is, before any 
updates to the VibroSight software corresponding to updates to VibroSmart 
modules), VibroSight Configurator should be used to obtain a copy of the 
configuration as follows:  

For a VibroSmart using a VibroSight Server, the File > Open > Server / Database 
command can be used to read the configuration from the VibroSight Server. 

For a VibroSmart not using a VibroSight Server (that is, a “stand-alone” 
VibroSmart), the File > Open > Device command can be used to read the 
configuration directly from the VibroSmart modules. 

Then the File > Save As > File command should be used to store a copy of the 
configuration for the VibroSmart distributed monitoring system. 

 

Update the firmware on a VibroSight device using the  Change Firmware tool (from VibroSight System 
Manager’s Maintenance tools): 

1. Ensure that the computer running the VibroSight software is on the same network as the hardware (XMx16 
card or VibroSmart module or device) to be updated. 
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2. Start VibroSight System Manager and navigate to the Devices tree structure in the System Explorer window. 

The Devices tree lists all of the VibroSight compatible hardware that VibroSight can see on the network. If 
there are no XMx16 cards or VibroSmart devices in the tree structure or some cards are missing, verify your 
network connections. 

3. Select the card or device that requires its firmware to be changed. 

The Actions tool window updates to show the available tools. 

To change multiple VibroSmart to use the same version of firmware at the same time, use CTRL+click or 
SHIFT+click to select multiple devices from the Devices tree-view. (Then, when the Change Firmware 
command is run, all of the devices that were selected will be updated at the same time.) 

4. Click  Change Firmware in the Maintenance tools group of the Actions window. 

The Change Firmware dialog box appears. 

5. Click the Add button and select the new firmware files for the card or new firmware file for the device. 

 NOTE: The Change Firmware dialog box automatically opens the firmware folder 
corresponding to the VibroSight-compatible VM600Mk2/VM600 module/card or 
VibroSmart device selected. 

In general, .tgz files are for VM600Mk2/VM600 modules/cards and .*fw files are for 
VibroSmart devices. 

 

6. Click the Finish button to start the firmware upgrade process. 

For XMx16 cards and VibroSmart devices, the firmware upgrade process can take up to 5 minutes, during 
which: 

• The IP address beside the device’s serial number in the Devices tree structure can disappear. 

• The LEDs on the front panel of the device can change to reflect the status of the upgrade. 

7. Repeat steps 3 to 6 for each device that requires a firmware update. 

 NOTE: Although the firmware for each VibroSight device must be changed individually 

using the  Change Firmware tool, as each device updates its firmware 
independently of the VibroSight software (once the process has started), firmware 
updates can be performed on several devices in parallel. 

 

8. After the firmware upgrade, verify that the VibroSight system is acquiring data from the cards. 

 NOTE: Refer also to the Changing the firmware topics in the  VibroSight help. 
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The  Change Firmware tool can be used to load a VibroSight device with any version of firmware. It is 
therefore possible to change a device’s firmware to any previously available version, as well as the latest update. 

This feature can be useful in certain situations, for example, swapping spare VibroSight hardware between different 
VM600 racks or VibroSmart distributed monitoring systems, where systems are operating with different versions of 
VibroSight. 

 

7.3 Final checks 

After upgrading the VibroSight software, it is recommended to check that VibroSight has not been inadvertently 
modified and that it continues to operate normally. 

 

In particular, it is recommended to check any VibroSight Servers in order to ensure that the data acquisition and 
external interfaces, data post-processing and/or logging are all configured as expected. 

 

In a VibroSight Server user interface: 

• On the Status tab under Device drivers, check that the VM600, VibroSmart, OPC and Modbus controls are 
enabled or disabled as required by your application. 

• On the Status tab under Server features, check that the Basic math, Air gap, Combustion monitoring, Duration 
counters, VSHDA import and Data logging manager controls are enabled or disabled as required by your 
application. 

• On the Log messages tab, check the listed messages (Info level) to ensure that the hardware 
(VM600Mk2/VM600 modules/cards and /or VibroSmart modules) have been discovered and that data acquisition 
has resumed. 

NOTE: When a VibroSight Server is running as a Windows service, the usual VibroSight 
Server user interface is not displayed, so VibroSight System Manager must be 
used to work with the VibroSight Server. 

That is, VibroSight System Manager can be used to connect to a VibroSight Server 
in order to check and configure the operation of the server’s drivers and features. 

 

 

Finally, after an upgrade, it is strongly recommended to use VibroSight Vision to connect to any VibroSight Servers 
in order to verify that new live and/or historical data is available. 
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8 Customer support 

8.1 Contacting us 

Meggitt SA worldwide customer support network offers a range of support including Technical support and Sales 
and repairs support. For customer support, please contact your local Meggitt representative. Alternatively, contact 
our main office: 

Customer support  
Meggitt SA 

Route de Moncor 4 
Case postale 
1701 Fribourg 
Switzerland 

 

Telephone: +41 (0) 26 407 11 11 
Email: energysupport@ch.meggitt.com 

Website: www.meggittsensing.com/energy 

 

8.2 Technical support 

Meggitt SA technical support team provide both pre-sales and post-sales technical support, including: 

• General advice 

• Technical advice 

• Troubleshooting 

• Site visits. 

 

8.3 Sales and repairs support 

Meggitt SA sales team provide both pre-sales and post-sales support, including advice on: 

• New products 

• Spare parts 

• Repairs. 

 

 

mailto:energysupport@ch.meggitt.com
http://www.meggittsensing.com/energy
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VibroSight software and Windows® operating system compatibility 

 

 
Windows 11 Windows 10 Windows 8.1 

VibroSight software compatible? Yes Yes 

Yes 
but not recommended for new 

installations as Microsoft mainstream 
support ended in 2018 

(extended support will end in 2023) 

 

 

VibroSight software and Windows® Server operating system compatibility 

 

 
Windows Server 2022 Windows Server 2016 Windows Server 2012 

VibroSight software compatible? Yes Yes 

Yes 
but not recommended for new 

installations as Microsoft mainstream 
support ended in 2018 

(extended support will end in 2023) 
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VibroSight software and Microsoft® .NET Framework requirements 

VibroSight software version Microsoft .NET Framework requirements 

VibroSight 3.7.0 or later .NET Framework 4.7.2 See note 1 

VibroSight 3.4.0 or later .NET Framework 4.7.1 See note 2 

VibroSight 3.0.0 or later .NET Framework 4.6 

VibroSight 2.12.0 or later .NET Framework 4.5 and .NET Framework 2.0 See note 3 

VibroSight 2.9.4 or later .NET Framework 4.5 

VibroSight 2.9.3 and 2.9.2 .NET Framework 4 (Standalone Installer) 

VibroSight 2.9.1 or earlier .NET Framework 3.5 SP1 
 

Notes 

1. Microsoft .NET Framework 4.7.2 replaces .NET Framework versions 4.0 to 4.7.1. 

2. Microsoft .NET Framework 4.7.1 replaces .NET Framework versions 4.0 to 4.7. 

3. Since Microsoft .NET Framework 3.5 also includes .NET Framework 2.0 and .NET Framework 3.0, installing Microsoft .NET Framework 3.5 SP1 is the recommended solution for most computers (rather than 

installing Microsoft .NET Framework 2.0). 
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